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1 What is DanioVision?

daniovision

DanioVision™ is a system for high throughput tracking of zebrafish 
larvae in multi-well plates. It consists of:

The DanioVision Observation Chamber (DVOC-0050)

See Figure 1. This chamber contains a transparent holder with backlight 
that fits an ANSI SBS compatible multi-well microtiter plate, infrared 
(IR) and white light sources underneath the microtiter plate, and a 
Gigabit Ethernet (GigE Vision) video camera. The optical design 
provides a stable and undistorted top view of each well and a 
controlled and constant environment within the observation chamber.

For technical specifications and for cleaning instructions, see System 
specifications.

EthoVision® XT

Video-tracking software with the Multiple Arenas Module and Trial & 
Hardware Control Module. With this module you can adjust the white 

Figure 1  The DanioVision Observation Chamber DVOC-0050.
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light stepwise based on time or behavior of your fish. You have the 
option to connect external devices, such as sound or shock generators.

Note that DanioVision DVOC-0050 works with EthoVision XT 18 and 
newer, and with an Ethernet connection (RJ45 port) to the EthoVision 
XT computer.

tip  You find your DanioVision’ version number on the label at the back 
of the chamber.

 

daniovision add-ons

DanioVision Temperature Control Unit

With the DanioVision Temperature Control Unit you can set up a water 
flow at constant temperature underneath the well-plate. For details, 
see The DanioVision Temperature Control Unit on page 80.

DanioVision Tapping Device

With the DanioVision Tapping Device you can trigger a startle response 
in zebrafish. For details, see The DanioVision Tapping Device on page 
117.

DanioVision Toplight Unit

With this add-on you can generate top-down light stimuli in your 
experiments. Four types of light are available: white, red, blue and 
green. For details, see The DanioVision Toplight Unit on page 127.
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DanioVision with Optogenetics

DanioVision can be provided with one to three LEDs that illuminate the 
well plates based on your Trial Control protocol. The Optogenetics add-
on allows to accurately control and time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (one for each well in 
a 96-well plate). For details, see The DanioVision Optogenetics add-on 
on page 139.

Custom solutions

As research evolves, so do research needs. If you are interested in a 
custom solution, don’t hesitate to contact us!

A few examples of recent custom solutions:

 Light-Dark Grid. Commonly used to investigate anxiety behavior in 
zebrafish. The grid is placed underneath the well plate (available for 
6, 12, 24, 48 or 96 wells) and creates a dark and light half in each 
well. The grid is IR light translucent, leaving the tracking of the 
zebrafish unaffected.

 High-speed camera. DanioVision is equipped with a camera 
capable of 1000 frames per second. The aim is to measure the 
startle response of larvae to a stimulus during a Pre-Pulse Inhibition 
test (Burgess and Granato 2007). 

 Split basin. The DanioVision basin has been modified so that it 
receives water at two different temperatures. The aim of this 
solution is to measure temperature preference in zebrafish larvae. 

 Ultraviolet Toplight Unit. This is a modification of the Toplight unit 
(see the previous page), which shines UV light. Light intensity is 
controlled by EthoVision XT.

 Turbo-cooling TCU. This is a modified Temperature Control Unit 
which keeps water at a constant temperature of 12° in a room 
where temperature is about 25°.
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for more information

Manuals

For more information, see

 The EthoVision XT Help (press F1 in the EthoVision XT).

 The EthoVision XT - Trial and Hardware Control - Reference Manual. 
To open this and other manuals, from the Windows Start menu 
choose All Apps > Noldus > EthoVision XT 18 Other Documentation.

You can also find the manuals on the Noldus web site.

my.noldus.com

After login, choose Downloads > EthoVision XT > Documentation.

Sample experiments

On the EthoVision XT downloads page you can find two sample 
experiments that make use of DanioVision. Browse to my.noldus.com, 
then after login choose Downloads > EthoVision XT > Sample 
Experiments. 

Once you have downloaded a sample experiment file (*.evz), you can 
open it in EthoVision XT (File > Restore Backup).

Experiment templates

EthoVision XT contains templates that help you setting up an 
experiment with arenas, analysis profiles and other elements already 
defined. See create a daniovision experiment on page 42.

References

See our web page of selected publications:

www.noldus.com/daniovision/resources

Support center

If after reading this manual you still have questions, please contact our 
Support center at my.noldus.com.
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2 What’s new in DanioVision

daniovision observation chamber

The interface of DanioVision DVOC-0050 has been completely 
redesigned.

 Communication with the EthoVision XT computer goes through 
Ethernet.

 There are pre-defined communication lines for the White Bottom 
Light, the TopLight Unit, the Tapping Stimulus, the DanioVision 
Temperature Control Unit DVOC-TCU and the Optogenetics setup.

 Two BNC connectors are reserved for the Optogenetics setup.

 Two TTL ports are available for additional hardware control. Each 
port includes two input lines and two output lines.

 There is a new physical connection for communication with the 
temperature sensor in the Temperaure Control Unit.

 You can switch on the White Bottom Light manually. To do so, 
operate the button at the right side of the camera. See page 19.

ethovision xt

 Because the hardware components have changed, the software 
interface for controlling DanioVision has changed. You can find it in 
the EthoVision XT Experiment Settings. Choose Setup > Experiment 
Settings, select Use of Trial Control Hardware. Click Settings and 
choose DanioVision DVOC-0050/TCP.

See experiment settings on page 45.

 The White Light Stimulus is now called White Bottom Light.

 The Tapping Stimulus stays as is. See The DanioVision Tapping 
Device on page 117.
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 The TopLight Unit has now specific names: White Top Light and 
RGB Top Light, for white and multi-color LED arrays, respectively. 
See The DanioVision Toplight Unit on page 127.

 When programming the White Bottom Light on/off actions, you 
can set the fade duration in milliseconds, seconds, minutes, and 
hours (maximum 24 hours).

 To know more about the new features in EthoVision XT, see the 
topic What’s new in EthoVision XT in the EthoVision XT Help.
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3 Set up DanioVision

connections

1. Temp out. Connector for the temperature sensor. Use this in 
combination with the DanioVision Temperature Control Unit (TCU; 
see page 80).

2. TTL A and B. Use those ports to control external devices such as a 
speaker or an additional light source different from the available 
add-ons (see page 8). 

note  Each TTL port contains two input lines (Input 1 and Input 2) 
and two output lines (Output 1 and Output 2). Which line you want 
to use must be specified in EthoVision XT (Trial Control Settings).

3. Trigger out 1 and 2. BNC connectors for output TTL signals. Use those 
connectors to trigger the Prizmatix Pulser or the Prizmatics LED 
controller in Optogenetics experiments.

Figure 2  The back panel of DVOC-0050. See the text for explanation.
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note  If you work with three Pulsers or LED controllers, use one of 
the TTL connectors for the third device. For this you need a special 
cable from TTL and the BNC connectors of the Pulser/LED controller.

4. Ethernet port for controlling DanioVision from the EthoVision XT 
computer. 

5. Ethernet port for the DanioVision camera. 

6. Connector for water inlet (see page 16 for details).

7. 24 VOLT connector for the power supply.

8. Connector for water outlet (see page 16 for details).

9. Connector for water overflow (see page 16 for details).

connect daniovision

Video

Use the Ethernet cable with the large round connector to connect the 
digital video output of the DanioVision Observation Chamber (Figure 3) 
to the Ethernet port labeled DanioVision camera on the EthoVision XT 
computer.

Figure 3  Basic connections between the EthoVision XT computer and DanioVision 
DVOC-0050. 
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The DanioVision camera must be connected to a 1-Gb Ethernet 
interface board. See page 23 for how to install this card on your 
computer. Note that the port on the Ethernet must be given a 
compatible IP address, for example 192.168.1.51. 

If you have purchased a PC from Noldus together with DanioVision, 
this card is already installed and the correct IP is assigned. Contact 
Noldus if you need a new Ethernet card for the DanioVision camera.

Ethernet

To control the White Bottom Light, the Tapping Device, and other 
hardware, connect the Ethernet port of the DanioVision Observation 
Chamber  to an Ethernet port on the EthoVision XT computer using the 
network cable with connectors of type RJ45 that comes with 
DanioVision.

 If you have purchased the computer from Noldus when you 
purchased DanioVision DVOC-0050, an Ethernet interface board 
with multiple Ethernet ports is already installed on that computer.

 In all other cases,  We advise to install a dedicated Ethernet 
interface board with 2+ ports, so you can use the on-board Ethernet 
port to connect to the internet.

IP addresses of the Ethernet ports

The two Ethernet ports on the PC must be given different IP addresses:

 Ethernet port connected to the Ethernet connector in DanioVision 
(number 4 in Figure 2): 192.168.20.1

 Ethernet port connected to the DanioVision camera (number 5 in 
Figure 2): 192.168.1.51

For how to assign IP addresses, see Step 3. Assign the IP address to the 
Ethernet card on page 25. 

Power

Connect the DanioVision Observation Chamber’s 24 VOLT socket to the 
power supply using the power cable and adapter (Figure 3).
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set up a water-flow system

If you require a temperature-controlled water flow underneath the 
well plate, the Noldus DVTCU Temperature Control Unit is the preferred 
method.

The back panel of the DanioVision Observation Chamber contains 
three connections for controlling the water flow (see Figure 5): a water 
inlet (marked in green), a water outlet (marked in yellow) and a water 
overflow (marked in red).

Figure 4  The DanioVision DVTCU Temperature Control Unit.

Figure 5  The back panel of the DanioVision Observation Chamber DVOC-0050, 
with the numbers indicating the connections of the water-flow system:
 1 - water inlet; 2 - water outlet; 3 - water overflow.
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Connect the DanioVision Observation Chamber to the DanioVision 
Temperature Control Unit using the tubes that match the color of the 
connectors. Please see page 80 for more details.

Suggested temperature

For Danio larvae, the temperature of the water flowing through the 
system is usually 28 degrees Celsius. You can set a different 
temperature when needed.

Figure 6  Tube connections between the DanioVision Observation Chamber and 
the DanioVision Temperature Control Unit. Color dots represents colors on the 
tubes. Arrows indicate the water circulation. 
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lights and switches

Main switch

The main switch is located on the front panel. After you switch on 
DanioVision, wait at least 15 minutes for it to ‘start up’ and to avoid 
condensation in the system.

 

Working light (not to be used during experiments)

The DanioVision Observation Chamber is equipped with a LED light to 
illuminate the inside of the chamber while you set up your experiment.

   ***REPLACE

Operate the Light switch at the *** left of the camera to turn the light 
on and off.
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Button for the White Bottom Light

This button is located on the metal frame at the right side of the 
camera. Press the button to switch the White Bottom Light on. Press 
more times to adjust its intensity. Once the maximal intensity is 
reached, press once to switch the light off.

Operate this button for example to have more background light when 
you check the larvae. 

 To have the White Bottom Light switched on per default during 
your trials, see page 45.

 For examples of how to use the White Bottom Light in your 
experiments, see page 60.

Anti-Moisture switch

This switch is located on the metal frame, at the *** left of the camera. 

Operate this switch to adjust the anti-condensation mechanism (page 
35).
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install ethovision xt

Before you start

 If you have purchased the DanioVision Observation Chamber 
including a computer from Noldus Information Technology, all 
software has been installed and tested. You can skip this section. 
See Set up EthoVision XT on page 42.

 If you use your own computer (or a computer you bought from 
Noldus IT in the past; in that case, make sure it meets the 
EthoVision XT system requirements), see below. For information 
about system requirements, press F1 in EthoVision XT.

Install EthoVision XT

1. If you do not have the EthoVision XT installation files, browse to the 
MyNoldus portal:

https://my.noldus.com/download/latest/ethovision-xt
- Log in or register (if you are a new user you can use the 

registration code which you can find on the Welcome letter). 

- Click Versions and download the EthoVision XT - Installation 
Package [version number].zip. Save th zip file on your PC.

- If you store the zip file on a network drive, copy it to your PC 
before the next step.

2. Unzip and extract the files on your computer. 

3. Double-click EthoVision XT - Setup - [version number].exe.

4. Continue installation choosing the interface language and the type 
of installation (Standard). Then click Next.

5. Accept the default Application location and Experiments location. 

6. Under Drivers and Tools, select the Basler GigE camera driver.

7. Complete installation and click Close.

Upgrading old experiments

When you open an experiment from EthoVision XT 12 or earlier, a 
warning appears informing you that you cannot open upgraded 
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experiments in the old version of the software anymore. Do one of the 
following:

 If the older EthoVision XT version is still on the PC, make a backup 
of your DanioVision experiment in that version before opening it in 
EthoVision XT. To make a backup, choose File > Make Backup.

 If the older version is no longer on the PC, you cannot use the 
Backup function. Instead, make a copy of your experiment using 
Windows Explorer before you open it in the newer EthoVision XT 
version. Always copy the complete experiment folder and not only 
the *.evxt file otherwise your experiment does not open. Keep the 
original experiment as a backup.

For more information

See Installation in the EthoVision XT Help for more details about 
installing EthoVision XT.

drivers and additional software

Camera driver software

If, for any reason, you need to re-install the driver software of the 
DanioVision camera, do the following:

1. Double-click the file EthoVision XT 18 - Setup [version number].exe 
and choose Modify. 

2. Under Drivers and tools, select to install the Basler GigE Camera 
driver and follow the instructions on the screen.

If you do not have the installation files, download the EthoVision XT 
Installation Package from

my.noldus.com

Installing the camera driver software from the installation file

You can download the single installation file for the Basler camera 
driver. However, if you choose this route you must select the custom 
setup, as described below. Follow the instructions carefully.
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Browse to

my.noldus.com

1. After login, choose Downloads > EthoVision XT > Drivers and Tools 
and under Drivers for the current version download Basler Pylon 
Camera Driver - Noldus - [latest version]. Extract its content and 
copy everything to the local disk.

2. Double-click Basler_pylon_[version number].exe. Accept the Terms 
and Conditions, then click Next.

3. Under Profiles, select Custom and click Next. 

4. Under Features, choose GigE Camera Support. This applies to the 
DanioVision camera. Make sure to select pylon Viewer and 
DirectShow Support. 

5. Complete the installation.

For more information, open the EthoVision XT Help and browse the 
chapter Camera Installation.

DanioVision hardware interface software

The hardware interface software for DanioVision DVOC-0050 is 
installed automatically when you install EthoVision XT.

 To de-install this software, do the following:

a In the Windows Control Panel select Programs and features.

b Click Noldus HardwareInterface DanioVision - x64 Package - 1 
and select Uninstall.

 To re-install the DanioVision interface software, run installation of 
EthoVision (see above) and select Repair. 

note  Older version of DanioVision are controlled by the Noldus – 
HardwareInterface IoBox – x64 Package – 5. Probably you have found 
this software under Programs and Features. You can uninstall that, 
provided that you are sure you no longer use older versions of 
DanioVision and any version of the USB-IO box in combination with 
EthoVision XT.
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install the network interface board

 If you ordered a computer from Noldus Information Technology 
when you purchased DanioVision, it came with that card already 
installed and tested. You can skip the instructions below and 
continue with Check the DanioVision system on page 32.

 If you bought your computer somewhere else, you have to install 
the Ethernet card yourself. Follow the steps below.

Type of Ethernet interface board

In order to use DanioVision, you need to have a 1-Gb Ethernet interface 
board (also named Network Interface Card, NIC) installed on the 
EthoVision XT computer.

For DanioVision DVOC-0050, you need an Ethernet board with at least 
two ports: one for the DanioVision camera and one for controlling the 
various devices inside DanioVision. 

Step 1. Insert the Ethernet card in the DanioVision computer

1. Turn off your computer and all connected peripherals, such as the 
monitor and printer. Make sure that the computer is unplugged.

2. Remove the PC's casing according to the instructions provided in the 
PC's user manual.

3. Select a free PCIe expansion slot, and remove the corresponding 
extension cover.
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When possible, choose the slot that gives maximum performance. 
To estimate performance, take note of the slot version (2, 3, etc.) 
and compare it with the following values:
- PCIe v1.x: 250 MB/s
- PCIe v2.x: 500 MB/s
- PCIe v3.0: ~1 GB/s
- PCIe v4.0: ~2 GB/s
- PCIe v5.0: ~ 4 GB/s

- PCIe v6.0: ~8 GB/s

Note that values are given per lane; they should not be multiplied 
by the number of lanes in a slot (e.g. x4) since the card has a 1x 
connector (that is, one lane). For example, SLOT1-PCIe3x4 means 
version 3.0 with four lanes.

important  Do not insert the PCIe board in the blue or white slots.

4. Unpack the Ethernet card, place it into the slot, and press it carefully 
into position. If the card does not fit into place easily, remove it and 
repeat the operation.

When touching the board, its electronic components can be 
damaged by static electricity. To avoid any such risk, make sure that 
you are grounded. You can ground yourself by putting on an 
earthing wristlet, and attaching its clip to the metal frame of the 
computer. If an earthing wristlet is not available, you can hold the 
metal frame with one hand while holding the Ethernet card in your 
other hand. Ensure also that your clothing does not touch any 
components while handling the card.
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5. Fix the card to the chassis and re-fit the computer's cover.

For more information about installing the camera and the Ethernet 
board, see Camera Installation in the EthoVision XT Help.

Step 2. Install the camera driver

The camera driver is already installed when you installed EthoVision XT 
provided that during installation under Drivers and Tools you selected 
Basler GigE camera driver.

If you have not done so, follow the instructions below.

1. If you have not done so, download the cameras driver software 
from my.noldus.com. Log in or register, then choose Downloads > 
EthoVision XT > Drivers and Tools. Under the EthoVision XT version 
that applies, download the Basler Pylon Camera Driver - Noldus - 
[version number].

2. Double-click Basler_pylon_[version number].exe. Accept the Terms 
and Conditions, then click Next.

3. Under Profiles, select Custom and click Next. 

4. Under Features, choose GigE Camera Support. Also select pylon 
Viewer and DirectShow Support. 

5. Complete the installation.

6. Connect an Ethernet port on your computer to the Ethernet port of 
DanioVision, (see 5 in Figure 2), using a network cable.

Step 3. Assign the IP address to the Ethernet card

tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

For DanioVision DVOC-0050: Repeat this procedure two times: one for 
the port of the Ethernet board for connecting the camera, and one for 
the other connection. 

1. In Windows (here version 10), search for Network Connections. 

2. Right-click the Local Area Connection and click Properties. If your 
computer has more than one Local Area Connection, choose Basler 
GigE Vision Adapter. Write down the number of this connection.
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tip  To know which port each item refers to, disconnect the cable 
from that port and check where the Disconnected symbol appears.

3. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

4. Select the options: Use the following IP address and Use the 
following DNS server addresses and fill in the details as shown in 
the next figure. 
- Ethernet port connected to the DanioVision camera (Figure 3): 

192.168.1.51.
- Ethernet port connected to the Ethernet connector in 

DanioVision (Figure 3): 192.168.20.1.

Also select the checkbox Validate settings upon exit. When done, 
click OK and then Close. 
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Step 4. Set the IP address of the DanioVision camera

tip  Watch the video tutorial Set Up the Camera. In EthoVision XT, 
choose Help > Video Tutorial.

1. In Windows, search for IP Configurator and start this application.

2. Select the camera. 

3. Fill in the details in the IP Address and Subnet Mask fields under 
Static IP Address as shown in the figure below. 

4. Click Save and then Close. 

5. Follow the instructions below to configure the DanioVision camera.

For more information about setting IP addresses, see Install GigE 
cameras in the EthoVision XT Help.
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Step 5. The IP address of the DanioVision chamber

The IP address of DanioVision DVOC-0050 is 192.168.20.50 and is set at 
production. 

Please make sure the IP address that you set on the Ethernet port of 
the PC connected to the Ethernet connector of DanioVision matches 
that IP address, that is, the first three numbers must be the same. 
Thus:

 Ethernet port on DanioVision: 192.168.20.50 (preset).

 Ethernet port on PC: 192.168.20.1.

For setting the IP address, see page 25.

configure the daniovision camera

Camera settings

The DanioVision camera that you received is already configured 
according to your setup. Noldus created three main settings profiles, 
called User Sets, stored in the Pylon Viewer software which controls the 
camera: User Set 1, User Set 2 and User Set 3. Only one User Set can be 
active at a time.

For each video resolution, you must use different camera settings and 
in some cases a different camera lens. For example, the video 
resolution determines the maximum frame rate. The higher the 
required resolution (in number of pixels), the lower the maximum 
frame rate (in frames per second). The three User Sets are specific for a 
combination of video resolution and frame rate (Table 1).

note  Pylon Viewer is installed when you install the Camera driver 
software. See Camera driver software on page 21. For more information 
about Pylon Viewer, see the Configure the digital camera in the 
EthoVision XT Help.
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1 User Set 1 is default for most applications. User Set 2 is pre-selected if 
you purchased a 12 mm lens and you work with a high frame rate. User 
Set 3 is pre-selected if you purchased a 8 mm lens.

2 For User Set 2, Binning mode must be Summing. For other User Sets 
either option has no effect with binning equal to 1.

3 For all User Sets: Enable Acquisition Frame Rate must be selected.

Table 1  Overview of predefined User Sets in the camera driver software and 
associated video frame rate, video size and required camera lens.

Resolution and
maximum frame rate

1280 x 960,
30 fps

640 x 480,
60 fps

800 x 600,
60 fps

Camera lens 12 mm 12 mm 8 mm +
0.5 mm
spacer ring

Settings in Pylon Viewer

A User Set1 User Set 1 User Set 2 User Set 3

B Pixel Format Mono 8 Mono 8 Mono 8

C Analog Gain 1 0 1

D Center X and Center Y

E Horizontal binning, 
Vertical binning2

1, 1 2, 2 1, 1

F Exposure TIme (Abs) 
in microseconds 3 

4000 2000 4000

Settings in EthoVision XT

G Resolution 1280 x 960 640 x 480 800 x 600

H Frame rate (fps) 30 60 60

I Color space Y800 Y800 Y800
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Which User Set is currently selected?

Make sure that EthoVision XT is closed. Start the Basler Pylon Viewer 
software and in the Features panel (for details, see the procedure in the 
next pages), under Configuration Sets, look for the item Default 
Startup Set. This is the User Set that contains the current settings.

Always check that the settings in Pylon Viewer for a particular User Set 
correspond to those in the table!

Note

EthoVision XT reads the settings from the camera driver software. For a 
specific EthoVision XT experiment you can override the values of video 
resolution and frame rate values that are stored in the driver, not other 
settings; see page 45.

The maximum frame rates have been measured with a 96 well plate 
setup. Other values may be optimal in other setups.

Adjust the camera settings in EthoVision XT

In EthoVision XT, choose Setup > Experiment Settings and click the 
camera button. Adjust the settings according to the table on the 
previous page.

For details, see Adjust camera Settings in EthoVision XT in the 
EthoVision XT Help.

Adjust the camera settings in Pylon Viewer

You can also adjust the camera settings directly in the camera software 
Pylon Viewer. Adjust the settings according to the configuration you 
want to use in Table 1. First, choose a video resolution and frame rate 
combination, then mount the recommended camera lens, and next 
make the appropriate settings in Pylon Viewer. Finally, adjust the 
appropriate settings in EthoVision XT.

For more information about Pylon Viewer, see the Configure the digital 
camera in the EthoVision XT Help.

 Pixel format (column B inTable 1). 

 Analog gain (column C in Table 1).
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 Center X and Center Y options (column D in Table 1). 

 Horizontal and Vertical binning (column E in Table 1).

 Acquisition frame rate and Exposure time (column F in Table 1).

tip  To preview the camera image, click the Continuous Shot 
button on the toolbar. 

tip  You can increase the Analog gain to 2 or higher if you need a 
brighter image. However, the image noise will also increase, which may 
influence tracking.

Do not forget to save the camera settings!

To save the settings, click the Stop button and open the 
Configuration Sets item. From the Configuration Set Selector 
list, select the User Set you want to save the settings to. Next to User 
Set Save, click Execute. Select the User Set you want to use at a daily 
basis. From the Default Startup Set list, select the User Set of your 
choice.

Camera view

Check that the camera view is correct by placing a wellplate in the 
DanioVision Observation Chamber. 

Make sure that:

 The well plate is in the middle of the field of view, not rotated or 
skewed. If not, see page 187.

 The well plate is in focus. If not, operate the focus ring of the 
camera lens.

 Fixation screws of all rings on the lens are tightened.

 The aperture is chosen such that the image appears slightly 
overexposed. With water in the well plate, the image is fine.

When you create an EthoVision XT experiment, check that the video 
Resolution, Video frame rate and Color space are as in Table 1 (page 29) 
for the User Set you want to use. 

See the next chapter and also Fine camera adjustments on page 184.
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4 Check the DanioVision system

Before you start setting up EthoVision XT, you need to check the 
following:

Camera

 The camera lens should have the correct aperture and must be in 
focus.

See page 33

 The camera is correctly configured.

See page 28

Anti-condensation mechanism

 You need to do this depending on the temperature inside the 
DanioVision chamber and the desired water temperature around 
the well-plate.

See page 35

White Light stimulus

 You need to do this when you want to use very low intensities for 
the DanioVision White Light.

See page 36

Well plates and Petri dishes

 The well plate or Petri dish must be inserted correctly.

See page 37

 Always control evaporation in the basin and in the well plate, 
especially when you carry out long trials (> 1 day).

See page 40
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check the camera lens

Although the camera and lens are set up before shipment, the settings 
of the lens can shift during transport. Before you start to work with the 
DanioVision system, please check that the lens is set up correctly by 
doing the following:

1. The lens you use depends on the video resolution and frame rate 
you want to use. See the table on page 29.

2. Insert a well plate (o petri dish) in the basin.

3. Create a new EthoVision XT experiment (see create a daniovision 
experiment on page 42) and open the Arena Settings to see the 
camera image.

When water is not present in the basin, the image of the well plate 
should look overexposed, like the following:

4. Check the focus (see Figure 7). If the camera image is not in focus, 
loosen the screw, adjust the focus and tighten the screw.

The camera should be focused on the animals. The distance 
between animals and camera does not change much between 
types of well-plate and water level in the wells, however it is always 
a good idea to check the image before an experiment and adjust 
the focus until it is optimized.
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5. Check the aperture ring (see Figure 7).

The aperture has been adjusted in such a way that when the basin 
is filled with water, the video image is optimal for tracking (see 
example of a good video image on page 188). However, in the 
Detection Settings (page 70) always check that detection of the 
larvae is good. If necessary, adjust the aperture to get a better 
contrast between the larvae and the background.

6. Make sure the camera is correctly configured (see page 28).

Notes

The more the lens aperture is set toward C (Close), the larger the so-
called depth of field is. This means that the subject looks ‘sharp’ in a 
wider range of distances from the lens. This is especially relevant when 
you work with a zoom lens and zoom in to focus on a smaller region of 
a well plate. If the aperture is set to O (Open), the subject may look 
sharp only at a certain water depth.

On the other hand, closing the aperture has the main disadvantage 
that it decreases the contrast between the subject and the background. 
Adjust the aperture until the image is optimized.

Figure 7  Left: a 12 mm standard camera lens. Right: A 8 mm camera lens. 
The 8 mm lens has a spacer ring already installed if you purchased this lens 
from Noldus. See also Table 1 on page 29 for which camera settings apply to 
which lens.
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configure the anti-condensation mechanism

Anti-Moisture switch

The Anti-Moisture switch is located behind the camera, at the left side.

The DanioVision Observation Chamber is equipped with an anti-
condensation mechanism to prevent water droplets forming on the 
lens during an experiment. A temperature sensor inside the 
DanioVision Observation Chamber checks whether the anti-
condensation mechanism should be switched on or off when it is set to 
Auto mode. Besides the Auto mode, you can also permanently switch 
the anti-condensation mechanism On or Off.

Auto 

Default and recommended when the DanioVision TCU is not used. The 
anti-condensation mechanism is automatically switched on when the 
air temperature inside the chamber drops below 28 °C (82.4 °F) to 
prevent condensation on the lens. When the air temperature inside the 
chamber exceeds 28 °C, the anti-condensation mechanism is 
automatically turned off to prevent heating of the water in the wells.

The value of 28 °C is a default setting of the embedded controller. 

note  If you use the DanioVision TCU, follow the instructions in the 
section The DanioVision Temperature Control Unit on page 80 and set 
the switch to either On or Off.

Off

The anti-condensation mechanism is permanently turned off. Use this 
mode when the air temperature inside the chamber is equal to or 
higher than the actual water temperature of the basin/well plate 
water (in most cases 28 °C). You can use this option in combination 
with the DanioVision TCU.

On

The anti-condensation mechanism is permanently turned on. Use this 
mode when the air temperature inside the chamber is lower than the 
water temperature in the wells. You can use this option in combination 
with the DanioVision TCU.
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configure the daniovision white bottom 
light

Light intensities in DanioVision DVOC-0050

In DanioVision DVOC-0050, the White Bottom Light levels are fully 
adjustable in the EthoVision XT Trial Control Settings (Action box for 
the White light).

See an example in create your own trial control procedure on page 
62

Low light option *** REMOVE 

It is possible to use very low light levels for the White light, that is, the 
stimulus light located under the well plate, in addition to the default, 
standard levels. The standard light levels range from ± 20 lux to ± 10000 
lux. The low light levels range from 0 to ± 20 lux.

Both standard and low light can be controlled in the same way by 
EthoVision XT’s Trial and Hardware Control. 

1. Open the DanioVision DVOC-004x chamber, and locate the switch, 
behind the camera, at the bottom-left of the black box.

2. Set the intensity of the White light.
- Right position H, standard high light level.
- Left position L, low light level.

Light intensities in DanioVision DVOC-0041

The intensities of the White LIght in DanioVision DVOC-0041 are the 
same*** as those of the White Bottom Light in DanioVision DVOC-
0050.

Percentage Steps Intensity (lux)

5 207 139

25 1000 2500

50 2100 5300

75 3000 8000

100 4095 10500
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Light intensities in DanioVision DVOC-0040

Below you find the reference values of the intensity of White Light in 
DVOC-0040:

You may want to replicate light conditions that you set in DanioVision 
DVOC-0040 in a new experiment with DanioVision DVOC-0050. 

For example, if you set light intensity to 50% in DanioVision DVOC-
0040, this gave 2950 lux based on the table avobe. The percentage to 
be set in DanioVision DVOC-0050 is (2950/5300)*50 = approx. 28%.

Thus, to find the percentage P50 that you need to set in DanioVision 
DVOC-0050 based on the percentage and intensity used in DanioVision 
DVOC-0040 (P40 and Lux40, respectively), follow this formula:

P50 = (Lux40/Lux50)*P40

Where Lux50 is the intensity in lux in DanioVision DVOC-0050  
corresponding to the percentage that was set in DVOC-0040. To find 
this intensity, see the table on page 36.

well plates and petri dishes

Well plates (ANSI standard)

1. Put the back of the well plate against the bridge and place it on the 
basin floor.

Percentage Steps Intensity (lux)

1% 40 70

25% 1025 1450

50% 2050 2950

75% 3000 4400

100% 4096 5450
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2. Tilt the front of the well plate down to the floor. This way the water 
in the basin pushes the air from underneath the well plate. Make 
sure the well plate is accommodated correctly between the metal 
springs at the front and at the right side.

tip  Drill a few holes on the sides of the well plate to allow air to 
escape when placing the well plate.
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Well plates (non-ANSI standard)

For smaller or larger well plates, place the bridge in a different position. 
The default position (ANSI standard) corresponds to the second hole on 
the side walls of the basin, when counting from the inner side of the 
observation chamber.

1. Remove the screws as indicated in the picture.

2. Slide the bridge by one or more positions. 

Check the video image in EthoVision XT, and make sure that the 
well plate is centered in the camera view. 

3. Fix the screws in the corresponding holes.
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Petri dishes

1. Put the Petri dish against the 90º angle of the bridge.

2. If necessary, remove the screws of the bridge (see above) and slide 
the bridge of a few positions until the dish is centered in the camera 
view.

With DanioVision you can use Petri dish of diameter up to 90 mm.

We recommend not to let water flow in the basin when using Petri 
dishes. Water may flow underneath the bottom of the dish, making it 
shift from its original position during a trial.

control evaporation

Wells on the sides of the well plate tend to show a higher rate of 
evaporation than wells in the center. Also, wells at the front have a 
higher evaporation rate than those at the back.

Our recommendations

In long experiments (> 24 h), evaporation may occur for both the wells 
in the plate and the basin. 

 Wells: Check the wells every 24 hours and if necessary, refill them.
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 Basin: Refill the basin every 2-3 days using the Basin Refill tool. For 
details, see the page 101.

The environmental conditions (temperature, relative humidity and air 
flow) and experimental conditions (lens heater on/off, White light 
intensity) influence the rate of evaporation (and condensation) of 
water from the basin and well plate. If you plan to carry out long 
experiments, always test evaporation at your environmental and 
experimental conditions, and plan refills to make sure that water drop 
never reaches a critical value.

tip  You can use a special syringe to refill the basin without having to 
open the DanioVision Observation Chamber. Contact Noldus for more 
information.
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5 Set up EthoVision XT

prerequisites

 Connect the DanioVision Observation Chamber to the EthoVision 
XT computer (see page 13).

 optional  Set up the water-flow system (see page 16). 

 Turn on the DanioVision Observation Chamber with the switch on 
the front panel. Wait at least 15 minutes for the DanioVision 
chamber to ‘start up’.

 Make sure to remove the lens cap from the camera.

Assign treatments to wells

To prevent systematic errors as a result of potential variation in 
temperature, light intensity or other unknown variable across a well-
plate, it is recommended to either assign larvae from different 
treatments randomly to the wells or make sure that wells containing 
different treatments (that is, different solutions or different 
concentrations of the same solution) are evenly distributed across the 
well-plate (so, for example, one type of solution is not only put in the 
center wells).

create a daniovision experiment

Preferred method

With this method, All arenas are created automatically, but need to be 
manually adjusted, using the Arrange Arenas option. Unnecessary 
functionality like manual scoring is removed from the interface and 
detection settings are optimized for DanioVision. 

1. In the EthoVision XT Startup window, under New experiment, click 
New from template, or choose File > New from Template.
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2. In the Select a template option window, click Apply a pre-defined 
template. Next, follow the instructions as described below.

3. Which video source will you use?

Select the option Live tracking (and saving video files), click the 
Sources button and select the Basler camera. Click Next >.

4. Which subjects will you track?

Select Fish and then Zebrafish larvae from the list. Click Next >.

5. How is the arena configured?

Select an Arena template from the list, then click Next >.
- Select one of the Well plate or Open field templates if you have a  

number of wells other than those listed in the other templates.
- Arena templates are also present for older DanioVision DVOC 

versions: DVOC 001x to DVOC 004x.
- To know which DanioVision version you have, see the code 

DVOC-00xx on the label located on the back panel of the 
DanioVision chamber.

6. Initialize template experiment. Check here that all settings are 
correct and, if so, click Finish.

7. Enter the name of the experiment and click OK.

The EthoVision XT Overview window opens.

8. Follow all the next steps:
- Experiment Settings. See page 45.
- Arena Settings. See page 51.
- Trial Control Settings. See page 60.
- Detection Settings. See page 70.

Notes

 If you select a template which contains more arenas than needed, 
you can exclude the unused arenas with Data selection (see page 
165).

 If you select a template for a DanioVision 1-3 version, it is possible 
that the DanioVision detection method does not give optimal 
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detection of the larvae with images from your camera. If that is the 
case, try to change the Sensitivity or use another detection method 
in the Advanced section of the Detection Settings pane. See also 
Configure Detection Settings in the EthoVision XT Help.

 You can also create an experiment based on a previous experiment. 
For example when you want to replicate an experiment with the 
same number of arenas, the same trial control procedures, etc.

Choose File > New from Template > Apply a custom template.

For details, see Create a new experiment based on an existing 
experiment in the EthoVision XT Help.

 You can also create a DanioVision experiment with no predefined 
settings. With this option you have to draw the arenas and arrange 
them manually. Choose File > New and in the window that appears 
select the option DanioVision experiment. In the Experiment 
Settings, next to Number of Arenas enter the number of wells.

We advise to create an experiment with a predefined template 
(page 42), because the arenas are defined automatically. For more 
information on creating an experiment manually, see Set Up an 
Experiment in the EthoVision XT Help. 

 No matter which method you choose, when you create a 
DanioVision experiment unnecessary functionality like the Manual 
Scoring Settings is removed from the interface and detection 
settings are optimized for DanioVision.
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experiment settings

Choose Setup > Experiment Settings.

Video Source

1. Under Video source, click the Video icon on the right 
side of the row of your camera. 

2. In the Video Settings window that appears, click the Formats tab 
and select the Resolution and Frame rate. Default resolution is 1280 
x 960 at 30 frames/s.

If you create an experiment based on a template with the Tapping 
Device, set the frame rate to 60 fps and reduce the resolution 
according to your setup (see the table on page 29).
See also the guidelines in columns G, H and I in Table 1 on page 29.

From the Color space list, choose Y800. This is the color space for a 
monochrome video image. The other options, suitable for color 
images, do not apply to DanioVision.
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Tracked Features

Specify whether you want to track the center point of the fish (default) 
or the center point, the nose point and the tail base. Choose the latter 
option only if you track fish in a close-up image. 

Body Point Detection Technique

The Contour-based technique is selected. The option Deep learning is 
not available in DanioVision experiments.

Analysis Options

If you are interested in how long and how frequent your subjects have 
been active vs. inactive, under Analysis Options select Activity analysis. 
Make sure you also adjust the Activity settings in the Detection 
Settings (see page 74).

For more information about setting up an experiment, see Set Up an 
Experiment in the EthoVision XT Help.

use of trial control hardware

Follow this section if you use stimulus devices like the white/color 
lights and the tapping stimulus device.

Procedure

1. In the Experiment Settings, under Trial Control Hardware, make 
sure that Use of Trial Control hardware is selected and click the 
Settings button.

2. In the Hardware Interface window that opens, choose the type of 
system you have.

If you have DanioVision DVOC-0050, choose DanioVision DVOC-
005x/TCP.
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The other options DanioVision DVOC-001x - 004x , if present, are 
meant for older versions of the DanioVision Observation Chamber. 
For details, see the Reference Manuals for those versions.

3. In the Device Configuration window, under Device features, the 
hardware devices activated for this experiment are listed.

4. optional  The default status of the DanioVision White Bottom Light 
if Light off. This means that, when you start a trial, the White 
Bottom Light is switched off. 

To use the White Bottom Light as a stimulus, program its activation 
with Trial Control. 

If, however, you want to use the White Bottom Light as a default 
lighting condition, and use the darkness as a stimulus, do the 
following:

a Click the White Light Default button. 

b Under Default device state, select Light on.
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c Choose a percentage of intensity (0-100) and click OK.

Then in the Trial Control procedure you can program when to 
switch the light off. See Trial Control Settings on page 60.

5. optional  If you connect additional hardware, under Plug-in devices, 
select the Device Type in the corresponding rows, depending on 
which ports on the DanioVision back panel you use to connect those 
devices.
- TTL Port A/ TTL Port B. For example if the DanioVision 

Temperature Control Unit is connected to the DanioVision 
chamber through TTL port A, choose DanioVision TC ( DVTCU-
001x) from the list next to TTL Port A. If you connect other 
devices, choose Custom Hardware.

- Trigger Out. If you connected the Optogenetics triggering 
devices/LED controllers to the DanioVision chamber through the 
Trigger Out BNC connectors, choose Optogenetics from the list 
next to Trigger Out. If you connected other devices through the 
BNC connectors, choose Custom Hardware.

6. optional  Edit the name in the Device ID.

7. Click OK.

8. optional  If you set the default state of the White Bottom Light to 
Light on, open the Trial Control Settings. This will confirm your 
selection. From that moment on, the White Bottom Light switches 
on at the start of the trial.

Notes

 If you upgraded an experiment from an older EthoVision XT version, 
do not change the Trial Control Hardware Settings in the 
Experiment Settings. For example, if you see Noldus Mini USB-IO 
Box selected in the Hardware Interface window, leave it as it is. 
Otherwise the Trial Control rules, for example to control the white 
light, may not work.

 When you change the default state of the White Light Stimulus to 
Light on, note that the white light is only switched on in one of the 
following cases:
- When you open the Trial Control screen.
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- When you open the Arena - Hardware Mapping window.
- When you start a trial.

 For more information on Trial and Hardware Control, see the 
EthoVision XT 18 - Trial and Hardware Control - Reference Manual.

ip settings

Aim

To ensure communication between DanioVision DVOC-0050 and 
EthoVision XT.

Background information

DanioVision DVOC-0050 is connected to your computer through the 
Ethernet port t the back of the chamber labeled Ethernet. This port has 
a specific, unique IP address: 192.168.20.50. To ensure communication 
between EthoVision XT and DanioVision, the IP address of the Ethernet 
port on your computer connected to DanioVision must match the 
address specified above. If you purchased the computer from Noldus, 
the IP address is already set. You can skip this section. Otherwise, 
follow the instructions below.

Procedure

1. In the Experiment Settings, under Trial Control Hardware, make 
sure that Use of Trial Control hardware is selected and click the 
Settings button.

2. In the Hardware Interface window that opens, choose DanioVision 
DVOC-005x/TCP.

3. In the DanioVision Configuration window, click Settings and check 
that the IP address is 192.168.20.50:
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4. Open the Network and Sharing Center in Windows.

In the Windows Search field, type in Control. Under Best match, 
click Control Panel, then Network and Sharing Center, then click 
Change adapter settings at the top-left corner of the window. 

5. Open the adapter settings and locate the item that corresponds to 
the port on your PC that is connected to the Ethernet connector on 
the back panel of DanioVision.

tip  To know which port each item refers to, disconnect the cable 
from that port and check where the Disconnected symbol appears.

6. Set the IP address, for example 192.168.20.1. See also Step 3. Assign 
the IP address to the Ethernet card on page 25.

Notes

If the DanioVision Configuration window shows the message Not 
connected to DanioVision, do the following:

 Make sure that the DanioVision chamber is switched on. Check the 
green LED light on the front panel.

 Check the cables between the computer and DanioVision.

 Make sure that the IP addresses of the Ethernet ports on the 
computer match those in DanioVision. See the figure on page 14.

 Click Refresh.
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6 Arena Settings

define the arenas automatically

Follow these instructions if your experiment was created for well 
plates with 6, 12, 24, 48 or 96 round wells, or 96 square wells, and this is 
the first new Arena Settings in your experiment. In other cases, see 
define the arenas manually on page 53.

tip  Use well plates with no notches between wells. These result in 
better well detection. Also make sure that the borders of all wells are 
within the camera image.

1. Place the well plate with water in the DanioVision chamber.

2. Choose Setup > Arena Settings > Arena Settings 1.

3. In the Grab Background Image window, click the Grab button to 
grab a background image of an empty well-plate from the camera 
image.

4. If EthoVision XT can detect the wells, the outline of the arenas are 
displayed over the background image. A message appears asking 
whether the arenas overlap with the wells in the image.
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5. Do one of the following:
- If there is good overlap like in the picture below, click Yes. 

If needed, you can always make small adjustments using the 
Arrange Arenas function (see page 55).

- If the arenas clearly do not overlap with the wells, or arenas 
overlap with each other, click No. The Arrange Arenas window 
appears automatically. See arrange the arenas on page 55 for 
details.

6. Click the 1. Draw Scale to Calibrate button.

Draw a line over the entire well-plate. Next, enter its size. Do this 
horizontally as well as vertically.

7. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 

Notes

 Arenas are marked with labels A1, A2,... B1, B2,... according to your 
well plate (letters indicate rows; numbers indicate columns)

 Success of automatic detection much depends on image contrast, 
focus, and distortion, and therefore we cannot guarantee it will 
work in all situations and with video made with DanioVision 
versions earlier than DVOC-0040. Automatic detection also does 
not work if water is not present in the well plate.

 If automatic detection of the wells does not work, it could be due to 
the well plate being not centered in the video image. Some wells 
are not visible, or only partially visible:
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See Fine camera adjustments on page 184.

 When the well plate image is optimal and centered, and still 
EthoVision XT shows the message Well plate detection failed, click 
OK and proceed with define the arenas manually on page 53.

 To start automatic well plate detection, click the Well plate 
detection button  at the bottom of the Arenas and Zones 
section of the Arena Settings pane.

define the arenas manually

The following instructions apply when the automatic well plate 
detection does not work properly. In that case you must define one 
arena and then make duplicates.

If you used a predefined template to set up your experiments, go to 
arrange the arenas on page 55.
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1. Click the 1. Draw Scale to Calibrate button, draw a line over the 
entire well-plate and enter its size. Do this horizontally as well as 
vertically.

2. If the current arenas are of shape different from that of the wells, 
select all arenas and press Delete.

3. Click 2. Select Shape and Draw Arena and use one of the shapes to 
create the first, top-left, arena. Make sure the label of the first arena 
(for example A1) points to the inside of the drawn arena. 

4. Click the outline of the arena or its label and then click the 4. Copy 
Arena button.

In the window that appears select All other arenas. Select the 
number of rows and click OK.

5.  Make sure the predefined arenas cover the wells. If you need to 
adjust the arena size and position, see arrange the arenas on page 
55. 
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arrange the arenas

Aim

To move, re-scale and rotate all the arenas simultaneously.

Procedure

1. in the Arena Settings window, click the 5. Arrange Arenas button. 

In the Arrange Arenas window, do the following:

2. To move all arenas: Under 1. Move Grid

To move up/down: Click the first slider. Move it the right (to move 
the arenas down) or left (to the arenas move up).

To move to the right/left: Click the second slider. Move it the right 
(to move arenas to the right) or left (to move them to the left).

You can also click the up/down arrow buttons of the corresponding 
box or enter a number in the box.

3. To scale all arenas: Under 2. Scale Arenas

Resize all shapes by using the sliders, by pressing the up/down 
arrows of the corresponding box or by entering a number in a box.

To increase the height of all arenas, use the first slider. To increase 
the width of all arenas, use the second slider
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By default the option Keep proportions is not selected. Then you 
can resize the height and width of all shapes separately. If you 
select Keep proportions, you can change either the height, or the 
width while keeping the aspect ratio. 

4. To rotate all arenas: Under 3. Rotate Grid

Optionally, rotate all shapes. This is only necessary if the well-plate 
is not positioned straight. The shapes rotate around the center of 
gravity of Arena 1.

5. To change the space between arenas: Under 4. Arena Spacing

Change the space between the shapes.

By default, the option Keep proportions is not selected. Then you 
can change the space between the shapes separately in the vertical 
and horizontal direction (relative to the first row and first column, 
respectively). If you select Keep proportions, change the spacing in 
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either the horizontal or vertical direction while keeping the aspect 
ratio. 

tip  First position the upper left arena in the desired position and 
make desired size (use scale). Next adjust arena spacing so all 
arenas are correctly positioned. See Using the Multiple Arena Setup 
in the EthoVision XT Help for information on setting up multiple 
arenas.

6. Click Validate Setup to validate the Arena Settings. Common errors 
are overlapping arenas, or zones falling outside an arena. If the 
setup is valid, continue with the instructions below. 

Edit a single arena

Click the row in the Arena Settings pane for that arena.

The corresponding arena is highlighted. Click the handles and move or 
resize the polygon.

For details on editing shapes, in the EthoVision XT Help see Arena 
Settings > Work with shapes.
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assign the stimuli to the arenas

Aim

To apply stimuli during a trial, for example a light pulse or a tapping 
stimulus.

If you created an experiment with a pre-defined template and selected 
the correct DanioVision arena template, the White Light Stimulus and 
the Tapping Stimulus have been assigned automatically to the arenas. 
The steps below are then not necessary.

Prerequisites

You have declared the port connections in use of trial control 
hardware on page 46.

Procedure

1. At the bottom of the Arena Settings pane, click the Arena - 
Hardware Mapping button.

2. In the Arena - Hardware Mapping window, do the following:

a Click Add device. 

b Locate the new row added to the list.

c Under Arena 1, select the device you want to add. For example, 
White Light Stimulus, or Tapping Stimulus.

Repeat the steps a to c for the other devices.

The devices only need to be assigned to Arena 1. They are in fact 
applied to all arenas.
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3. Click OK.

Test the devices

 To test a device, select the corresponding row in the Arena - 
Hardware Mapping window and click the Test button. 

 See also Test the hardware devices in the EthoVision XT 18 - Trial 
and Hardware Control - Reference Manual.

For more information

 About the Tapping Stimulus: see The DanioVision Tapping Device 
on page 117.

 About the TopLight Unit: see The DanioVision Toplight Unit on page 
127.

 About the Optogenetics add-on: see The DanioVision Optogenetics 
add-on on page 139.
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7 Trial Control Settings

default trial control settings

Choose Setup > Trial Control Settings > Default or White Light Routine.

Depending on which template you used to create your experiment, you 
will find two or three examples of trial control settings:

 Default - The default Trial Control Start-Stop rule. Use these 
settings to start and stop tracking manually.

 White Light routine. Use these settings when you want to provide a 
light stimulus during the trial. Ten minutes after the start of the 
trial, the DanioVision white light immediately turns on to 100% 
intensity for 10 minutes, then the white light immediately turns off 
for 10 minutes. This sequence of actions is repeated twice, using a 
sub-rule, after which the trial stops.

For more examples, see create your own trial control 
procedure on page 62.
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 Tapping Stimulus Routine. These settings contain a routine to 
produce a recurrent Tapping stimulus. For other examples, see page 
117.

Maximum trial duration (recommended)

 If you record video: 60 minutes.

 Without recording video: 72 hours.

You can in principle record video for more than one hour, however 
consider that DanioVision creates high quality video files, which occupy 
a large disk space. Depending on the frame rate and resolution, one 
hour recording may require more than 1 GB.

Set the duration of your trials in the Maximum Trial Duration pane or in 
the Start-Stop trial rule, by placing a Time condition immediately 
before the Stop track action box.

Tested configuration

 Camera video resolution: 1280 x 1024.

 Operating system: Windows 11 Pro, 24H2.

 Software: EthoVision XT 18.0.

 Experiment: DanioVision with 96 wells.

 Trial Control: Two subrules, one for the Tapping device and one for 
the White light. One Action every five minutes, for 30 minutes total 
per device type. Total duration of the test: two hours.



62  7 - Trial Control Settings

create your own trial control procedure

Aim

You can adjust these trial control settings to your own needs. The 
procedure below describes how to define Trial Control Settings from 
scratch.

Example

A researcher wants to expose the larvae to alternating periods with the 
white light on and off, in which the light-on periods also vary in 
intensity. This schedule is shown in the figure below.

To program this schedule:

1. To open the Trial Control, in the Experiment Explorer, right-click 
Trial Control Settings, select New, enter a name and click OK.

The Trial Control screen opens with the default Start-Stop trial 
control rule.

2. Click the Condition box with Infinite time and press Delete.

3. In the Components pane, under Actions - Hardware, click the button 
in the Add column next to White Light Stimulus. Select Create a new 
action.

4. In the Hardware Action window, set the following:
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- Action name. Enter a description of the action, for example 
“Light on 100%”.

- Action to perform. Select Light on from the list.
- Intensity level. Select the maximum intensity level of the light, 

in percentage (0 - 100%) or in Steps (0-4096). With the standard 
White Light settings, the light intensities of the white light are 
approximately: 

- Fade duration. For example, with Intensity level of 50% and a 
Fade duration of 2 seconds, the white light gradually turns on 
until 50% of its maximum intensity in 2 seconds time.

note  If your experiment was created from a template of 
EthoVision XT 17.0 or an earlier version, you could only set the 
fade duration in seconds. In the experiments created from 
templates in EthoVision XT 17.5 and later versions, you can set 
the fade duration in milliseconds, seconds, minutes and hours 
(up to 24 hours).

5. Click OK and insert the Action box in the sequence.

Percentage Steps Intensity (lux)

5 207 139

25 1000 2500

50 2100 5300

75 3000 8000

100 4095 10500
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6. In the Components pane, under Conditions, click the button next to 
Time. Click Create a new action and click OK. 

In the Time condition window, you can set the following:
- Condition name. For example, enter ‘Wait 15 mins’.
- Condition is met. For the option After a time of, enter ‘15 mins’.

7. Click OK and insert the Condition box in the sequence.

8. Repeat steps 3-6 to complete the Trial Control rule example 
described on page 62:
- Add an Hardware Action box with White Bottom Light - Off and 

a Condition Time box with “After 10 mins”.
- Add an Hardware Action box with White Bottom Light - On 50% 

and a Condition Time box with “After 10 mins”.
- Add an Hardware Action box with White Bottom Light - Off and 

a Condition Time box with “After 10 mins”.
- Add an Hardware Action box with White Bottom Light - On 

100% and a Condition Time box with “After 15 mins”.

tip  Combinations of Action and Condition boxes that are repeated 
in a sequence can be replaced with a sub-rule. This is especially 
handy when the entire sequence is repeated multiple times during 
a trial. For example: [White Bottom Light - On - 100%] > [After 10 
min] > [White Bottom Light - Off] > [After 10 min]...

For more information on using sub-rules, see also the EthoVision XT 
18 - Trial and Hardware Control - Reference Manual.

Figure 8  This combination of Action and Condition box turns the White 
Bottom Light on at 100% intensity and keeps it on for 15 minutes.
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9. Insert all the boxes in the correct order into the sequence and make 
sure you connect all boxes (see Figure 9 and Figure 10 on the next 
page for an example). To connect boxes, drag the mouse from the 
middle of one to the middle of the other.

Figure 9  Example of Trial Control Settings. This is the first half of the Start-Stop 
Trial rule. In this example of Trial Control Settings, the repeated combination of 
Action box ‘Light off - 0’ and Condition box ‘Wait 10 mins’ to turn the White 
Bottom Light off for 10 minutes, has been replaced by a Sub-rule (see also the 
Figure on the previous page).

Figure 10  Continued from Figure 9. This is the second half of the Start-Stop Trial 
rule. The Sub-rule is called a second time by the Reference box Light off (2).
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Notes

 Click Test in the Hardware Action window to test the hardware 
action.

 Click Reset to reset all Hardware Action windows in your Trial 
Control procedure to their default values (for example a White 
Bottom Light action is set to off; however if you set the default 
White Bottom Light to on (as explained on page 47), then after 
clicking Reset the white light switches on.

 To analyze data in the light or dark period, create first a Data profile 
that specifies that period using Trial Control State (see page 166). 
Then, calculate the statistics.

 For more information on Trial Control Settings, see Trial Control in 
the EthoVision XT Help, and the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual. To open this manual, from 
the Windows Start menu choose All Apps > Noldus > EthoVision XT 
18 Other Documentation.

use an external command

Examples of external command are:

 Play a sound during the trial.

 Start a batch file that triggers the presentation of a visual stimulus 
(e.g. a looming object) during the trial.

However, when you work with multiple arenas, the command is 
executed for each arena. For example, the command to play the sound 
is repeated 96 times for a 96 arena experiment. To prevent this from 
happening, use one of the following methods:

Method 1 - Condition in Arena 1

1. In the Arena Settings, create a zone in Arena 1 and call it “Zone 1A”. 
Make the zone as large as the arena. 
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2. In the Trial Control Settings, make a condition like “Is subject in Zone 
1A?”, followed by the external command. 

3. Insert a condition before the External command box, which will only 
become true for one of the arenas, for example Arena 1.

4. Make sure that the sequence does not interfere with the rest of the 
Trial Control rule. In the example of the next figure, the Condition 
box and the external command Action box have been placed in a 
separate branch. This way the execution of the external command 
does not influence the other actions in your trial control procedure.

Method 2 - Condition specified in a batch file

The Trial Control actions are by default executed for each arena 
independently. This means that an action would be executed as many 
times as the number of the areas. However, you want to present a 
stimulus once for all arenas simultaneously. 

When using a batch file, it is possible to use an IF condition to execute a 
command only for a specific Arena name. So the action is executed 
once for all arenas.

Suppose you want to have the following command executed, which 
triggers the presentation of an image stimulus on a monitor.

D:\Software\Frameless\Frameless.exe "D:\Images\Dot.jpg" mon=2 
fullscreen=yes duration=00:00:02
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This could be part of a batch file executed with the External Command 
function. However, as it is currently, it would executed as many times 
as the number of the arenas.

1. Create a text file with the following code:

@echo off

echo %1

IF %1=="Arena 1" (

D:\Software\Frameless\Frameless.exe 
"D:\Images\Dot.jpg" mon=2 fullscreen=yes 
duration=00:00:02

)

Make sure that the arena name in the code is exactly like that 
defined in the Arena Settings, including spaces. For example, if the 
name of the first arena in a DanioVision experiment is A1, then 
enter A1 in the batch file. Next, save the file with the extension bat, 
for example  ShowImage.bat.

2. In the Trial Control Settings, create an External Command and next 
to Select program to run select the batch file.

3. Next to Command line options, enter “%an%” (inlcuding the 
quotes). This makes EthoVision XT “listen” to the arena name ad 
execute the command only for the arena specified in the batch file.

4. Arrange the External command in your Trial Control procedure. In 
this example it has been placed in a sub-rule. 
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The stimulus is presented once every 10 seconds, no matter how 
many arenas are in the experiment.
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8 Detection Settings

What do you want to do?

 Track one subject per well/enclosure. See below.

 Track two or more subjects in the same enclosure. See page 74.

 Use Activity. See page 74.

one subject per enclosure

Choose Setup > Detection Settings > Detection Settings 1.

The DanioVision detection method

The template experiment contains a Detection Settings profile with 
DanioVision selected as method.

The DanioVision detection method is optimized for detecting small 
dark objects over a white/gray background, like in DanioVision 
experiments. Its main features are:
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 The difference with other methods is that DanioVision detects the 
subject based on the level of contrast within the well where the 
subject is. So you can view this method as Dynamic Subtraction 
applied to each well independently. This method should detect all 
subjects even when there are differences in lighting between wells.

 This method does use a reference image, just like Dynamic 
Subtraction, however you do not have to choose one. The software 
does that for you by taking the first video frame available. 

 After comparing the reference image with the current video image, 
DanioVision selects the pixels within the well that are more likely 
to be part of the subject. How “choosy” the software is depends on 
the Sensitivity. With a low value of Sensitivity the software 
considers pixels over a wider range of grey values as candidates. 
With high values, it picks pixels over a narrow range of grey values 
(see below).

 If some subjects are completely still, the software may not find 
them. If that occurs, gently tap the well plate to make the animals 
move. Once all the subjects are detected, adjust your settings.

important  If you have upgraded EthoVision XT to version 18 while you 
have a DanioVision system older than DVOC-0040, the DanioVision 
method does not give optimal detection of the larvae with images from 
your camera. If that is the case, adjust the Sensitivity (see below) or use 
another detection method in the Advanced section of the Detection 
Settings pane. For details, see the EthoVision XT Help.

Procedure

1. Place the well plate with the larvae in the DanioVision chamber 
and close the chamber door.

2. Click the Auto-detect button.
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important Use the Auto-detect button every time you change a 
well-plate.

3. The Auto-detect window with a timer appears. Wait until it has 
disappeared. All larvae should be detected well, like in this example:

What if some larvae are not detected or the software tracks noise?

Do one or more of the following:

 Open the Advanced section and under Method move the 
Sensitivity slider. Moving the slider to the left results in detecting 
more of the body of the larvae, but also more noise. Moving the 
slider to the right results in detecting less noise, but also gives less 
good detection of the larvae.

 If you see erratic tracks and spikes like that in the picture below 
(right), it means that small groups of pixels at the border of the well 
are sometimes detected as the larva. There is also too much noise 
(orange pixels). Move the Sensitivity slider to the right.

 If some larvae are not detected while they are in the corner or 
border of a well, check that the arenas are drawn well. Click the 
Show/Hide button on the toolbar and select Arena Features and 
then select the check box in front of Arenas.
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Check that the arenas cover the entire wells. In the example below, 
the arena on the right does not cover the left margin of the well.

The subject is not detected when it swims in that region.

 Try to maximize the contrast by opening the aperture of the camera 
lens (See “check the camera lens” on page 33.) However, make sure 
the light intensity is equal for all wells (that is, the center and outer 
wells).

 Certain compounds dissolved in the water can affect the 
pigmentation in the larvae, thereby decreasing the contrast of the 
animal and making detection of the animal more difficult. Make 
sure that EthoVision XT can still detect all animals after treatment.

 If detection remains unsatisfactory:
- It could be that the software tracks other objects outside the 

well. Restrict the arenas only to the part where the larvae swim.
- Try the Dynamic subtraction method. For an explanation of the 

options, see Configure Detection Settings in the EthoVision XT 
Help.

Notes

The method Dynamic Subtraction may also work fine with zebrafish 
larvae. In that case:
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 If your experiment is set to track the three body points (snout, 
center and tail), you can choose the Adult fish/For Occlusions 
method.

 If the experiment is set to Center-point detection only, choose 
either DanioVision or Dynamic Subtraction, with the Other species 
method to track the center point of the subjects.

activity analysis

Use Activity to quantify overall activity of your subjects. In the 
Experiment Settings (see page 46) select Activity analysis. In the 
Detection Settings pane, open the Activity section. Activity is shown by 
purple pixels in the video window. Set the Activity threshold in such a 
way that movements of the animals are detected and some noise is 
left.

For more information on activity, see Activity settings in the EthoVision 
XT Help. Also watch the video tutorial on Activity analysis.

For more general information on Detection Settings, see Configure 
Detection Settings in the EthoVision XT Help.

multiple subjects in the same enclosure

Prerequisites

in the Experiment Settings, Number of Subjects is set to 2 or higher.

Procedure

1. Choose Setup > Detection Settings > Detection Settings 1.

2. Click Automated Setup. One subject is detected per well. Play the 
video to check detection. 

3. Click Advanced, then Method, select DanioVision.

The following image is an example of multiple larvae being tracked 
with this method:
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Note that the subjects are not individually marked, so identity swaps 
do occur.
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9 Acquire data

There are three ways of acquiring data with your DanioVision system. 
For every option it is possible run single trials, but it is also possible to 
carry out batch acquisition. 

 acquire data live (page 77). The larvae are tracked as they move in 
their wells.

 acquire data live and record video simultaneously (page 78). 
The larvae are tracked as they move in their wells while at the same 
time a video is recorded. This gives you to opportunity to redo the 
tracking if necessary, either per trial or using batch acquisition.

 record video, then acquire data (page 79). You record a video first 
and then track the subjects offline from the video. Please note that 
if you only record video with EthoVision XT, Trial Control is not 
applied. So, for example, the white light is not switched on and off, 
if you only record video.

Before you start acquiring data, make sure you have carried out all the 
necessary checks of the system (see page 32).

Notes

 The DanioVision Observation Chamber is designed to block light 
from the outside. However, it cannot be guaranteed that it is 
completely dark inside the chamber. For experiments that require 
absolute darkness, place the DVOC in a dark room.

 important  In long experiments, evaporation may occur for both 
the wells in the plate and the basin. Check the wells every 24 hours 
and if necessary, refill them.

Refill the basin every 2-3 days using the Basin Refill tool. For details, 
see page 101.

 Please read the section in the next pages that applies to your setup. 
For more information, see Acquire Data in the EthoVision XT Help.



9 - Acquire data 77

acquire data live

1. Make sure the camera is connected to the EthoVision XT computer 
and that Live tracking is selected as Video Source in the Experiment 
Settings.

2. Optionally, plan your trials in the Trial list and select the Arena 
settings, Detection settings and Trial control settings for each trial. 

3. Choose Acquisition > Open Acquisition.

4. If no trials are planned, click the New trial button in the Playback 
Control window or press Ctrl+F3.

5. In the Acquisition Settings pane, select whether you want to track 
only the next planned trial or whether you want to track all planned 
trials without having to start the next trial manually.

If you want to track all planned trials, specify the inter-trial interval. 
Enter a time long enough to be able to change well plates. When 
you change the well plate between trials, you can start the next 
trial without waiting that the inter-trial interval is reached. To do 
this, click the Skip remaining interval button in the Playback 
Control window.

 

6. Select whether you automatically want to start the analysis after 
the tracks are acquired. If that is the case, first define your 
dependent variables in an Analysis Profile (see Analyze DanioVision 
data on page 172). Optionally, first make a Track Smoothing profile 
and a Data profile to make a selection out of your data. 

7. Select whether you want to use the Track smoothing profile, Data 
profile, and Analysis profile that are highlighted in blue in the 
Experiment Explorer for analysis, or that you want to run analyses 
for all possible profile combinations. In the latter case, first delete all 
profiles you do not need for analysis. If you want to carry out 
analyses for only a selection of profiles, deselect the check box Auto-
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start analysis and carry out batch analysis after acquisition (see step 
5 on page 176).

8. Put the well-plate into the DanioVision chamber.

9. Click the Auto-detect button. A Re-initialize window with a timer 
appears. Wait until it disappears.

important  Use the Auto-detect button every time you change a 
well-plate.

10.To start the trial, click the Start trial button in the Playback Control 
window (or press Ctrl+F5).

11. To stop the trials, wait until Trial Control automatically stops the 
trials. To stop acquisition manually click the Stop trial button in the 
Playback Control window (or press Ctrl+F6). If you stop the trials 
manually, automatic analysis does not start. Also, for batch analysis, 
the next trials are not started if you stop a trial manually.

note  The recommended maximum trial duration when acquiring live 
without recording video is 72 hours (3 days).

acquire data live and record video 
simultaneously

To save video when doing tracking, follow the procedure above, with 
the difference that in step 4 you select the check box Save video in the 
Acquisition Settings pane.

If you realize tracking was not optimal, you can re-do tracking from the 
acquired video.

note  The recommended maximum trial duration when acquiring live 
and recording video simultaneously is 60 minutes. Longer trials 
produce video files of excessive size, more difficult to manage. 
Furthermore, if one large video gets corrupted then you lose more data.
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record video, then acquire data

If you use the option Save video only, track later, Trial Control is not 
applied so you cannot control the white light of the DanioVision 
Chamber with EthoVision XT.

To save video when doing tracking, follow the procedure on page 77, 
with the difference that in step 4 you select Save video only, track later 
in the Acquisition Settings pane. Also make sure that the trial is time 
limited, either with a time condition in the Trial Control start-stop rule, 
or with a Maximum Trial duration setting (page 61).

Next, you can acquire data using batch acquisition. Plan your trials in 
the Trial list and specify the video and optionally Arena Settings, Trial 
Control Settings and Detection Settings for each trial.

note  The recommended maximum trial duration when recording video 
is 60 minutes. Longer video recordings produce files of excessive size, 
more difficult to manage. Furthermore, if one large video gets 
corrupted then you lose more data.

drain and clean the system

At the end of the experiment, we recommend to remove all the water 
from the basin and the tubes.

If you use the Temperature Control Unit, DV-TCU, set it to Fill/Drain and 
follow the instructions in the next section (page 80).

To prevent the growth of algae in the system:

 Always drain the system after use.

 Do not expose the system and the tubes to sunlight.
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10 The DanioVision Temperature 
Control Unit

introduction

The Temperature Control Unit DVTCU-001x allows you to set up a 
temperature-controlled water flow underneath the well plate in the 
DanioVision Observation Chamber. The result is a constant 
temperature in the well-plate throughout an experiment.

If you purchase the Temperature Control Unit, you get all the 
accessories necessary to work with the DanioVision system.

note  DanioVision users with a DanioVision Observation Chamber 
purchased before 25 January 2013 must upgrade their DanioVision 
Observation Chamber in order to be able to work with the Temperature 
Control Unit. Please contact your Noldus sales representative for more 
information.
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Workflow

1. connect the daniovision tcu. See below.

2. set up the daniovision tcu. See page 86. 

3. temperature alarm (optional). See page 93.

4. carry out an experiment. See page 99.

important  After the experiment, drain the DanioVision Observation 
Chamber and the DanioVision Temperature Control Unit. Also keep the 
tubing far from sunlight to prevent algae growth inside the tubing. See 
Drain the system on page 88.

connect the daniovision tcu

important  If you use a DanioVision system of version DVOC-0020/-
0021, you need to upgrade your DanioVision Observation Chamber to 
be able to connect the Temperature Control Unit. Contact your nearest 
Noldus office for more information. 

important  Make sure you place the DanioVision Temperature Control 
Unit at the same level as the DanioVision Observation Chamber. If that 
is not possible, place the DanioVision Temperature Control Unit at no 
more than 1.3 m below the DanioVision Observation Chamber.

Accessories

The Temperature Control Unit includes:

 A 1.5 m color-coded drain tube.

note  For connecting the DanioVision Temperature Control Unit, 
you also need the color-coded tubes that come with the 
DanioVision Observation Chamber DVOC-0050.

 A cable for the temperature sensor with a cinch-plug on both ends.
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 A 3-m network (UTP) cable to connect the TTL ports on the 
Temperature Control Unit and the DanioVision Observation 
Chamber.

 A bottle of liquid coolant and a funnel to fill up the coolant.

 The Basin Refill Tool, for filling the DanioVision basin with liquid 
without opening the DanioVision Observation Chamber (see page 
101).

 A power adapter GST120A24 and a power cord.
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Procedure

Connect the tubes between DanioVision and the TCU as shown here. 
See also Figure 13.

1. Connect the tube with the green color code to the connectors with 
the green ring on (see Figure 12 how to connect a tube) both the 
DanioVision Temperature Control Unit and the Observation 
Chamber (see 2 in Figure 13).This is the tube through which water 
flows into the DanioVision Observation Chamber.

Figure 11  Basic connections between the DanioVision Observation Chamber (left) 
and the Temperature Control Unit (right). Arrows indicate the direction of the 
water flow. Color dots indicate the color of connectors on the devices.

Figure 12  How to connect a tube to a TCU connector. 1 - Slide the nut of the 
connector onto the tube, 2 - Connect the tube to the connector, 3 - Screw the nut 
onto the connector.
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2. Connect the tube with the yellow color code to the connectors with 
the yellow ring on both the DanioVision Temperature Control Unit 
and the Observation Chamber (see 1 in Figure 13). This is the tube 
through which water flows out of the DanioVision Observation 
Chamber. 

Figure 13  The back panels of the DanioVision Observation Chamber DVOC-0050 
(top) and the Temperature Control Unit DVTCU-oo1x (bottom). The numbers of the 
connectors / ports are also described in the text above. Connectors with the same 
number are connected with the provided tubes with the same color-code. 
1 - Yellow connectors for water flow into the Temperature Control Unit and out of 
the Observation Chamber. 2 - Green connectors for water flow out of the 
Temperature Control Unit and into the Observation Chamber. 3 - Drain connector. 4 
- Water overflow connector. 5 - Connectors for the temperature sensor. 6 - TTL 
ports. 7 - Power connection of the Temperature Control Unit.
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3. Connect the tube with the blue color code to the connector with the 
blue ring on the DanioVision Temperature Control Unit (see 3 in 
Figure 13). This is the tube to drain the DanioVision system. Make 
sure this tube ends in a sink or container.

4. Connect the tube with the red color code to the connector with the 
red ring on the DanioVision Observation Chamber (see 4 in Figure 
13). This is the tube for the water overflow of the Observation 
Chamber. 

important  Make sure that the tubes with red and blue color codes 
end in a sink or container. The tubes run obliquely downwards so 
that water flows spontaneously to the sink/container.

5. Connect the cable with the cinch-plugs to the temperature-sensor 
connectors on both the DanioVision Temperature Control Unit and 
Observation Chamber (see 5 in Figure 13). 

6. Optionally, connect the network cable between the TTL port on the 
DanioVision Temperature Control Unit and one TTL port on the 
Observation Chamber (see 6 in Figure 13). This allows you to log 
temperature error messages and potentially use these in trial and 
hardware control in EthoVision XT.

important  If you have the DanioVision Observation Chamber 
version DVOC-0030 or older, you cannot use TTL2, because this port 
is used by the temperature sensor for the lens heater inside the 
observation chamber.

7. Connect the DanioVision Temperature Control Unit to the mains 
socket.

8. Connect the DanioVision Observation Chamber to the EthoVision XT 
computer (see page 14).
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set up the daniovision tcu

Fill and drain cycle

Before you start using the system, it is good to make sure that the 
whole water circuit is clean. For these steps you need demineralized or 
distilled water, and a water container or sink.

important  Always drain the system at the end of the experiments.

1 - Fill the system

1. Turn on the DanioVision Observation Chamber.

On the DanioVision Temperature Control Unit, switch the 
Operation mode to Fill/Drain.

2. Turn the Drain tap completely to Closed.

Water will flow as depicted in the following scheme:
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3. Slowly start pouring water into the basin of the DanioVision 
Observation Chamber.

important  Stop adding water when the water level reaches the 
edge of the basin indicated in red in the figure below).

As a result, the water starts flowing through the tubes. Pour more 
water a few times, until all bubbles in the tubes have gone and the 
basin is completely filled.
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2 - Drain the system

1. Keep the Operation switch to Fill/Drain and turn the Drain tap to 
Open. Water will flow as depicted here:

2. When the basin is empty, turn the Drain tap to Closed to remove all 
remaining water from the tubes and let it flow into the basin.

3. Turn the Drain tap to Open again, to completely drain the 
DanioVision Observation Chamber.

Normal use with set water temperature

1. Turn on the DanioVision Observation Chamber. 

important  After you turned on the Observation Chamber, wait at 
least 15 minutes before you start an experiment in EthoVision XT.
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2. Open the DanioVision Observation Chamber, and locate the Anti-
Moisture switch inside the chamber. Set the switch in one of the two 
modes.
- On. Choose this when the room temperature is lower than the 

desired water temperature.
- Off. Choose this when the room temperature is higher than the 

desired water temperature.

3. On the DanioVision Temperature Control Unit, switch the Operation 
mode to Fill/Drain.

4. Turn the Drain tap completely to Closed.

Water will flow as in the following scheme:
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5. Slowly start pouring water into the basin of the DanioVision 
Observation Chamber. 

important  Stop adding water when the water level reaches the 
edge of the basin indicated in red in the figure below).

important  We strongly recommend to use demineralized or 
distilled water to minimize contamination of the system and the 
accumulation of calcium and salt.

As a result, the water starts flowing through the tubes. Pour more 
water a few times, until all bubbles in the tubes have gone and the 
basin is completely filled.
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6. Close the DanioVision Observation Chamber before you set the 
desired temperature in the next steps.

7. Set the Operation switch to On. 

8. Next to the temperature display, hold the Set button for about 1 
second; the display flashes displaying the currently set temperature. 

9. Use the arrow keys to set the desired temperature. 

10.Confirm by pressing the Set button once. 

important  If the difference between the actual and set water 
temperature is more than 0.5 °Celsius / 0.9 °Fahrenheit, an error 
code appears (see feedback and error messages on page 108 for 
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more information). This error message disappears as soon as the 
water temperature is within a 0.5 °C / 0.9 °F range of the set value 
again.

11. Wait until the set temperature has been reached. This takes on 
average 10 minutes, depending on the set temperature and the 
temperature in the room. During this process, the status indicated 
by the LED lights at the front is on Heating / Cooling. Once the 
temperature is stable at the set value, the status changes to Ready.

The DanioVision Temperature Control unit is now ready to start an 
experiment. Make sure that the DanioVision Observation Chamber has 
been on for at least 15 minutes.

Displaying Celsius or Fahrenheit

You can choose to display the temperature in °Celsius or Fahrenheit. To 
set the display to Celsius or Fahrenheit, do the following:

1. Set the Operation switch to On.

2. Keep the Prg and Set button both pressed until the entry code 0 
appears on the temperature display.
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3. Use the arrow keys to change the entry code to 77 and press Set. 

Result: Program c0 appears on the display.

4. Use the arrow keys to go to program c18 and press Set.

5. Use the arrow keys to set the temperature unit to Celsius = 0 or 
Fahrenheit = 1 and press Set to confirm.

6. Keep the Prg button pressed until you exit the program mode.

temperature alarm (optional)

Aim

To log the high and low temperature alarm in EthoVision XT. You can 
use the temperature alarm:

 in the Trial Control Settings, for example to stop the trial if the 
temperature alarm lasts for more than a certain time. See page 96.

 In the Analysis profiles, to visualize when an alarm occurred 
together with the data. See an example on page 98.

 As a hardware log, which you can export. See page 99.

note  A temperature alarm should not happen if the TCU is in status 
“Ready”. An alarm is therefore an unusual event in normal conditions. 
If the TCU is still in “Heating” or “Cooling” status, it is normal that a 
couple of temperature alarm occur.

Cable connections: DanioVision DVOC-0050
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Connect the network cable between one of the TTL ports on the back 
panel of the DanioVision Observation Chamber and the TTL port on the 
back panel of the DanioVision Temperature Control Unit.

note  If you have the DanioVision Observation Chamber DVOC-0030 or 
older, connect the TTL port of the Temperature Control Unit to TTL ports 
3 or 4 on the Observation Chamber. Do not use TTL port 2!

Define the temperature alarm in EthoVision XT

1. In EthoVision XT, create a DanioVision experiment. For details, see 
page 42.

2. In the Experiment Settings, under Trial Control Hardware, click the 
Settings button. Select the version number of your DanioVision 
Observation Chamber and click OK.

3. In the Device Configuration window, under Plug-in devices, choose 
the TTL port that you used to connect the Temperature Control Unit.

Under Device Type, select DanioVision TCU (DVTCU-001x). Under 
Device ID, type in a name or accept the default name DanioVision 
TCU (DVTCU-001x) 1. Next, click OK.

4. Choose Setup > Arena Settings > Open and choose the Arena 
Settings you use in the experiment. In the Arena Settings window, 
click the Arena - Hardware mapping button. 
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5. In the Arena - Hardware Mapping window, click the Add device 
button. 

6. In the new row that appearsa, under Device type select DanioVision 
TCU (DVTCU-001x). Under Device name enter a name, for example 
“TCU Temp alarm”. In the column A1 (or Arena 1, depending on how 
the first arena is named), select the Device ID that you defined 
above.

7. Click OK. EthoVision XT is now ready to log the alarm signals from 
the TCU.

Possible alarm signals

The following TTL signals are sent to EthoVision XT and can be used as 
usual in the Trial Control Settings and Analysis Profiles:

 When the current water temperature is within the normal 
temperature range, that is, a temperature that deviates by less than 
0.5 °C from the set temperature: [Tset -0.5°C ≤ Tcurrent ≤ Tset+0.5°C), 
no alarm is given. Both Low temp error state and High temp error 
state are false. 

 When the current water temperature is more than 0.5 °C lower 
than the set temperature (Tcurrent < Tset -0.5°C), a ‘low-temperature 
alarm’ is given and Low temp error state becomes true.
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 When the actual water temperature is more than 0.5 °C higher than 
the set temperature (Tcurrent > Tset +0.5°C), a ‘high-temperature 
alarm’ is given and High temp error state becomes true.

 When you turn off the Temperature Control Unit or unplug the 
network cable from the TTL port, both Low temp error state and 
High temp error state become true.

note  During a temperature alarm, the TCU tries to bring the 
temperature back to the normal range, so you do not need to take any 
particular action.

Program the temperature alarm

Use a temperature alarm in the Trial Control Settings for example to 
stop tracking or start an external program when a temperature alarm 
occurs. Here you find how to program the alarm based on the water 
temperature.

note  During a temperature alarm, the TCU tries to bring the 
temperature back to the normal range, so you do not need to take any 
particular action with Trial Control.

1. prerequisite  You have defined the temperature alarm in 
EthoVision XT (page 93).

2. Choose Setup > Trial Control Settings > Open (an existing profile) or 
New to create a new profile.

3. In the Trial Control Settings, under Conditions click the button next 
to DanioVision TCU (DVTCU-001x).
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4. The Hardware Condition window appears. In the Condition name 
field, enter a name for the condition; for example, TCU Low Temp 
alarm.

5. From the DanioVision TCU list, select the device name that you 
defined in the Arena - Hardware Mapping window. 

The name listed next to DanioVision TCU could be Device A, Device 
B, etc. or e.g. TCU Temp Alarm depending on whether you edited the 
device name in the Arena - Hardware Mapping window; see page 
95.

6. Choose one of the two:
- To take an action when an alarm occurs, next to Signal to check 

choose either Low temp error state? or High temp error state? 
depending on the alarm you want to use. Then next to Signal 
value select true.

- To take an action when the number of temperature alarms 
reaches a certain value, next to Signal to check choose either 
Low temp errors or High temp errors and select the threshold of 
alarm errors.
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7. Insert the condition box in the Trial Control rule. 

Where to place the condition depends on what you want to happen. 
For example, if you want EthoVision to stop tracking when the 
condition is met, place the condition box immediately before the 
Action - Stop track box.

For more information about working with conditions and actions, see 
Trial Control in the EthoVision XT Help and the EthoVision XT 18 - Trial 
and Hardware Control - Reference Manual.

The temperature alarm in data analysis

You may want to visualize alarm events in the Integrated Visualization. 
This way you can review your trials and see if something has changed 
in the behavior of the larvae during or after those alarm events.

1. In an Analysis Profile, under Hardware, click the button next to 
Hardware state.

2. Next to Device type, choose DanioVision TCU (DVTCU-001x).

3. Next to Device, choose the name given in the Arena - Hardware 
Mapping window (“TCU Temp alarm” in the example above).

4. Next to Signal:
- To visualize or calculate the duration of the time that the system 

was in temperature error state during the trial, select Low temp 
error state for a low-temperature alarm, or High temp error 
state for a high-temperature alarm. Next to Value select true. 
Select false if you want to visualize or calculate the time that 
there was no temperature alarm. 

- To visualize or calculate the duration of the time when the 
system had more (or less) a certain number of temperature error 
alarms, choose Low temp errors or High temp errors. Choose 
whether the number of errors was higher/lower or equal to a 
threshold value. Keep the option Cumulative selected.

5. In the Trial Statistics tab, select the statistic you want and click OK.

6. optional  Right-click the row Hardware state and select Rename. 
Enter a custom name; for example, Hardware state Low Temp alarm.

7. Choose Analysis > Results > Plot Integrated Data.
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The figure below shows examples of how temperature alarm events 
are visualized in the Integrated Visualization.

The temperature alarm in the hardware log

To export the hardware log that contains the TCU alarm events, do the 
following:

1. Choose Analysis > Export > Raw Data.

2. In the Raw Data Export window, make sure to select the Hardware 
log check box.

3. Click Start export to export the data.

carry out an experiment

Before you start

If you want to log temperature errors, configure EthoVision XT 
beforehand. See temperature alarm (optional) on page 93.

Procedure

1. Set the water temperature. Follow the procedure Normal use with 
set water temperature on page 88.

2. Wait that the temperature has reached the set value and no error 
codes appear on the LCD screen of the TCU.

3. Insert a well plate with the larvae into the basin. To prevent air 
getting trapped underneath the well-plate, put the back of the well 
plate against the wall with the shape of “∧” and place it on the basin 
floor, then tilt the front of the well plate down to the basin floor.
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As you do this, water flows into the over-flow part of the basin.

4. Lower the Fresnel lens over the well plate and close the DanioVision 
Observation Chamber. You can now carry out an DanioVision 
experiment as usual.

5. If necessary, grab a background image and define the arenas (page 
page 51) and define the Detection Settings (page 70). See also the 
EthoVision XT Help.

6. Choose Acquisition > Open Acquisition. Start the trial.

7. At the end of the experiment, follow the procedure 2 - Drain the 
system on page 88.

important  Draining prevents contamination from building up 
inside the system. Before you drain the system, make sure the drain 
tube with blue connector ends in a sink or container.

View the temperature alarms during the trial

 On the Temperature Control Unit:

If an error occurs in the Temperature Control Unit, an error message 
appears on the display. See feedback and error messages on page 
108 for an explanation.

 On the EthoVision XT screen:

a Choose Show/Hide > Show Dependent Variable.

b From the Select hardware list, choose Hardware state. Click OK.

c Next to Device type choose DanioVision TCT (DVTCU-001x). 
Choose the signal you want to display. Click the Statistics tab and 
choose the statistics of that signal that you want to display.
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tip  Choose Current to display whether a temperature alarm is 
occurring.

d During acquisition, in the Analysis Results and Scoring pane click 
the Dependent Variables tab. There you can view the alarm state 
(under the arena A1). Here, true means error state.

refill the basin during long experiments

The Basin Refill Tool

During prolonged DanioVision experiments, evaporation of water out 
of the basin could be an issue. You can compensate for evaporation by 
refilling the basin without opening the DanioVision chamber.

The Basin Refill Tool (DVBR-0010) allows you to refill the basin without 
opening the DanioVision Chamber during an experiment. It is provided 
standard with the DanioVision Temperature Control Unit (DVTCU).

important  It is possible to fill/refill the basin directly by pouring water 
in the basin. However this is not practical when an experiment is 
running.
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Only use the Basin Refill tool in combination with the DanioVision 
Temperature Control Unit (DVTCU).

Set up the Basin Refill Tool

Do this before starting the experiment.

1. Make sure your DanioVision basin is empty. To do so, follow the 
instructions in the Section 2 - Drain the system on page 88.

2. Disconnect the tube marked in green between the DanioVision 
Chamber and the Temperature Control Unit (when applicable).

3. Connect the ends of the tubes of the Basin Refill Tool to the 
corresponding green-marked inlets at the back of the DanioVision 
Observation Chamber and the Temperature Control Unit:

4. Make sure the faucet of the Temperature Control Unit is closed (Off 
position).

5. Fill the syringe with basin liquid, and connect it to the short faucet 
tube.

6. Fill the basin circuit (see page 88).

tip  While the basin circuit is being filled, insert a few ml liquid out 
of the syringe in order to prevent air bubbles from getting into the 
circuit. 

7. Start the experiment as usual.
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Use the Basin Refill

How much liquid to insert via the syringe depends on the level of 
evaporation and the duration of the experiment. Add liquid into the 
basin circuit whenever needed.

During refill, do not switch off the Temperature Control Unit!

1. Open the faucet (On position).

2. Make sure you can see the overflow outlet of the DanioVision 
Chamber (red marked tube).

3. Gently push the syringe to insert liquid. 

4. Carefully watch the overflow tube. Whenever the liquid comes, stop 
pushing the syringe.

notes

 Overflow is a good indication for a 100% filled basin, however it 
may lag on filling.

 The DVTCU will, whenever occur, compensate any temperature 
fluctuation due the refill. However, make sure that the liquid 
temperature in the syringe is not too far from the desired basin 
temperature.

To refill the syringe

1. Make sure the faucet is closed (Off position).

2. Disconnect the syringe. 

3. Fill the syringe with basin liquid.

4. Make sure no air is present in the syringe.

5. Connect the syringe back to the faucet tube.
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maintenance and support

Replace the filter

The filter inside the DanioVision Temperature Control Unit is a particle 
filter with a pore size of 20 μm. The filter does not remove bacteria 
and/or yeast.

tip  The filter can get blocked after you have used the system for a 
longer period of time. When this happens, you will get an ‘insufficient-
flow’ error message. Please first check the error table (page 108). 
Contact Noldus IT to order a new filter.

important  Before replacing the filter, drain the system (see page 88 for 
how to do this).

1. Make sure to use demineralized or distilled water to prevent small 
particles (> 20 μm) from blocking the filter.

2. Open the lid of Temperature Control Unit by unscrewing the white, 
plastic screw at the front of the unit. You can use a small screwdriver 
or a coin to do this.

3. Remove the left side panel by unscrewing the two screws at the top 
and three screws at the bottom of the side panel (indicated in the 
figure below).
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4. Lift the filter from the clamp and disconnect the tubes at both ends 
from the filter.
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5. Insert the new filter, connect the tubes and push the filter back into 
the clamp. Make sure the small black arrow on the filter points in 
the direction as shown in the figure above.

6. Put the side panel back in place and close the lid of the Temperature 
Control Unit.

Replace the liquid coolant

1. Open the lid of Temperature Control Unit by loosening the plastic 
screw at the front of the unit.

2. Remove the left side panel by unscrewing the screws at the top of 
the side panel (see the figure in step 2 on page 104).

3. Locate the cap on top of the reservoir for the liquid coolant. This 
differs slightly between TCU versions (see the figures below).

4. Unscrew the cap using for example a small coin.

5. Use the funnel to fill the reservoir with the liquid coolant.
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We recommend to fill it to maximum level.

After refilling the liquid coolant, turn the Operation switch to Fill/
Drain to make sure the tubes inside the Temperature Control Unit 
are also filled with liquid coolant. As a result, the level of coolant in 
the reservoir might drop a bit. Add more coolant so it reaches the 
Max level.

6. Screw the cap back on the reservoir.

7. Put the side panel back in place and close the lid of the Temperature 
Control Unit.

Make sure to regularly check that the level of coolant does not drop 
below the Min indication on the front of the Temperature Control 
Unit. If the level is too low, refill the coolant.

Contact Noldus IT if you want to purchase a new bottle of liquid 
coolant.

Wear and tear

All Noldus hardware is sold with a two-year guarantee. That means 
that if it breaks within two years of the delivery date, it will be repaired 
or replaced at Noldus' expense. Please see the document ‘Noldus 
guarantee’ to see what is covered by the guarantee.

Wear and tear caused by regular, normal use of the DanioVision 
Temperature Control Unit is not covered by the guarantee. Below are 
some recommendations about environmental conditions and cleaning 
of the Temperature Control Unit.

Environmental conditions

See the specifications on page 192, under Environmental conditions.
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Cleaning the TCU

To clean the DanioVision Temperature Control Unit, use a damp cloth. 
Please do not use chemicals or soap to wash the Temperature Control 
Unit. Make sure that no liquid gets into the Temperature Control Unit.

For how to clean the DanioVision chamber, see page 191.

Keeping the tubing clean

It is very important that the tubes are kept as dry as possible when not 
using the DanioVision and the TCU. To prevent the growth of algae in 
the tubing, do the following:

 Always fill the system with demineralized water, and drain it after 
the end of an experiment.

 Keep all units and the tubes far from sunlight.

Technical support

If after reading this manual you still have questions, please contact our 
help desk at my.noldus.com.

Event data logger

If you purchased a DanioVision Temperature Control Unit after 
November 2016, this is equipped with a board and a compact SD card 
that records performance data during functioning. If you encounter 
problems when using the Temperature Control Unit, the Noldus Help 
desk may ask you to send the files stored in the card. In that case, the 
Noldus help desk will send you the instructions for how to that.

feedback and error messages

The DanioVision Temperature Control Unit gives feedback about its 
status with four LED lights and error codes on the temperature display.

For the LED lights on the front panel: see below.

For the indicators on the temperature display: page 114

For the error codes displayed on the temperature display: page 115.
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LED indicators

Status LED Explanation What to do?

Filling / 
Draining

Orange - 
blinking

System is 
pumping.

The system can be filled with 
water 
(see step 5 on page 90).

Water can be drained from the 
basin 
(see page 88).

Cooling liquid can be filled (see 
page 106).

Filling / 
Draining

Red - 
continuous

Time out. There 
has been no 
flow in the 
water circulation 
and/or the 
cooling liquid 
circulation for > 
10 minutes.

Reset the system by turning the 
Operation switch to Off and 
then back to Fill/Drain.

Heating / 
Cooling

Green - 
blinking

The water is 
being heated/
cooled to the set 
temperature.

Wait. No action needed.
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Ready Green - 
continuous 

The set 
temperature has 
been reached 
and the system 
is ready to be 
used.

The Temperature Control Unit is 
ready to be used and an 
experiment 
can be started.

Error Red - 

1 blink - 
repeatedly

Insufficient flow 
in the water 
circulation.

Look for the source of the 
problem. This may be: 

 Low water level in the basin 
(due to evaporation or 
leakage). In this case, fill 
the system (step 5 on page 
90).

 Flow blockage somewhere 
in the system or filter 
clogged. See page 104 or 
contact Noldus to replace 
the filter.

 Pump failure.

The Fill/Drain mode can be used 
to localize the problem. Reset 
the system by setting the 
Operation switch to Off and 
then to Fill/Drain.

Status LED Explanation What to do?
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Error Red - 

2 blinks - 
repeatedly

Insufficient flow 
in the cooling 
liquid 
circulation.

Look for the source of the 
problem. This may be: 

 Low cooling liquid level in 
the pump reservoir. Check 
if the liquid level is above 
the indication. If not, refill 
cooling liquid (see page 106 
for instructions) and check 
for signs of leakage in the 
emergency liquid container.

 Flow blockage somewhere 
in the system.

 Pump failure.

The Fill/Drain mode can be used 
to localize the problem. Reset 
the system by setting the 
Operation switch to Off and 
then to Fill/Drain.

Error Red -

3 blinks - 
repeatedly

The fan is not 
spinning, or not 
spinning at 
sufficient speed.

Check if there is anything 
blocking the fan. If this is not the 
case, please contact Noldus 
support. 

Status LED Explanation What to do?
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Error Red - 

4 blinks - 
repeatedly

System is 
overheated.

Turn off the system and end the 
experiment. Cooling liquid can 
be cooled down by switching the 
Operation switch to Fill/Drain. 
Search for the possible cause of 
the overheating:

 Air vents of the 
Temperature Control Unit 
might be blocked so the 
radiator cannot get rid of 
its heat. Make sure air 
vents are free.

 System is used in 
environmental conditions 
that have not been tested, 
for example, room 
temperature >35°C.

Error Red - 

5 blinks - 
repeatedly

Heating and 
cooling have 
been activated 
simultaneously. 
An electrical 
problem has 
occurred.

Please contact Noldus support.

Status LED Explanation What to do?



10 - The DanioVision Temperature Control Unit 113

Error Red -

6 blinks - 
repeatedly

A problem with 
the data logger 
has occurred.

Open the TCU and take the SD-
card out. 

 If it is locked, unlock it.

 Check that it has a 
minimum capacity of 4 GB.

Next, put the SD-card back in the 
TCU. If the error persists, take 
the card out, and format it 
(FAT32). Leave the card empty; do 
not copy the old files to the 
newly-formatted card. Next, put 
the SD-card back in the TCU and 
restart the TCU.

Error Red - 
continuous

A temperature 
deviation larger 
than 0,5°C above 
or below the set 
temperature has 
been detected. 

Water conditioning will continue 
to try to resolve the situation. 
Once the situation is resolved 
the status of the system returns 
to 'Ready'.

Depending on your protocol you 
can choose to continue or to 
abort the experiment.

Status LED Explanation What to do?
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Temperature display

0

Code Explanation

1 The water is being heated to the set temperature.

2 The water is being cooled to the set temperature.

3 The current water temperature is at least 0.5°C below the 
set temperature. It is shown together with the 
temperature alarm code E05. In normal conditions, when 
code 3 is shown, code 1 is also shown and the red Error LED 
(re-continuous) is on.

4 The current water temperature is at least 0.5°C above the 
set temperature. It is shown together with the 
temperature alarm code E04. In normal conditions, when 
code 4 is shown, also code 2 is shown and the red Error LED 
(re-continuous) is on.

Error mode (see page 115)

This is a system setting indicator, which blinks when the 
TCU is in heating/cooling mode. No action need be taken.
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Error codes

LCD is off A possible reason is that one of the flat cables coming from 
the LCD display is not properly connected. Open the DV-
TCU, locate the multi-color flat cable (3rd to the right of the 
CD card), disconnect it and connect it again. 

Error code Explanation What to do?

E01 The temperature 
sensor is not 
detected.

Please connect the temperature 
sensor cable (with cinch-plugs on 
both ends).

E04 ‘Too high’ 
temperature alarm. 
The measured 
temperature is 0,5 °C 
higher than the set 
temperature. See 
‘Red – continuous’ 
LED on the table 
beginning on page 
109.

Depending on your protocol you can 
chose to continue or abort the 
experiment. Please note that this 
error also occurs while the system is 
Heating/Cooling before the start of 
the experiment; the system 
continues to heat/cool to try to 
resolve the error.

Code Explanation
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E05 ‘Too low’ 
temperature alarm. 
The measured 
temperature is 0,5 °C 
lower than the set 
temperature. See 
Error with ‘Red – 
continuous’ LED on 
the table beginning 
on page 109.

Depending on your protocol you can 
chose to continue or abort the 
experiment. Please note that this 
error also occurs while the system is 
Heating/Cooling before the start of 
the experiment.

Ed1 System error. See Status = Error on the table 
beginning on page 109.

nO Another display has 
been selected 
accidentally.

1. Press the up or down arrow until 
the code b1 appears on the display.

2. Press the Set button for three 
seconds to confirm. 

Error code Explanation What to do?
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11 The DanioVision Tapping Device

introduction

Larval stage zebrafish display a robust startle response, which is 
mediated by neural pathways similar to that in higher vertebrates. 
With the DanioVision Tapping Device you can evoke a startle response 
in zebrafish larvae.

How the Tapping Device works

The DanioVision Tapping Device is based on an electromagnetically 
inductive coil wound around a metal core. The core is made of two 
parts, a fixed one and a plunger connected to a push pin. When a 
current flows in the Tapping Device, magnetic force is created between 
the plunger and the core, causing the plunger and the push pin to 
quickly move forward (as indicated by the blue arrow in the picture). 
The pushpin hits a metal plate attached to the basin in which the well 
plate is kept. When deactivated, a spring makes the plunger resume its 
position.
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Controlling the Tapping Device

With the Trial and Hardware Control module of EthoVision XT you can 
plan when to activate the Tapping Device during a trial. For example, 
activate the Tapping Device 10 times at intervals of two minutes. 

Noldus test results: a summary

 In both light and dark conditions, the Tapping Device is capable of 
inducing a startle response in animals of 3 dpf and older. 

 It is in principle possible to design experiments where the animals 
are subject to stimuli of different intensity. You can set the tap 
intensity in EthoVision XT (page 121). 

 There is no evidence that the startle response measured by 
EthoVision XT depends on light conditions and location of the 
subject in the well plate.

important  We advise you not to compare the results between two 
DanioVision Observation Chambers provided with the Tapping Device. 
Slight differences in the position of the Tapping Device may result in 
differences in the actual stimulus intensity, all else being equal!

install the daniovision tapping device

If you order the Tapping Device together with a DanioVision 
Observation Chamber, the Tapping Device is already installed. In all 
other cases:

1. Open the lid of the DanioVision Observation chamber, and remove 
the bench plate (see also page 178).
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2. Remove the two bolts from the aluminium plate at the bottom of 
the chamber as indicated in the figure below. Make sure that the 
backlight box does not move.

tip  Use a pencil to mark the exact position of the backlight box on 
the frame so that you can place it in that position if it accidentally 
moves.

 

3. Put the metal frame of the Tapping Device over the aluminium 
profiles, and fix the bolts with the supplied spring washers. Use 
both the already connected spring washers and the new ones.
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4. Connect cables as indicated here.

a The cable with a 4-pin white connector comes from the Tapping
Device.

b The flat cable with a blue connector comes from the bottom of 
the DanioVision chamber. Raise the metal hooks, insert the 
connector, then lower the hooks to fix the connector.

c The cable with 2-pin connector comes from the bottom of the 
DanioVision chamber.
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5. Attach the control box to the aluminium profile at the front side of 
the observation chamber. 

a Insert the screw in one of the hole at the sides of the control box.

b Attach the spacers and the sliding nuts to the screw.

c Insert the sliding nuts into the profile, and turn the screw. 

6. Put the bench plate back into place and fix the four screws.

set up the tapping device in ethovision xt

Make sure that the DanioVision Observation Chamber is connected to 
your EthoVision XT computer.

Experiment Settings

1. Under Trial Control hardware select Use of Trial Control hardware, 
next click Settings. 

2. In the Hardware Interface window, select DanioVision DVOC-0050/
TPC.

tip  You find your DanioVision’ version number on the label at the 
back of the chamber.
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3. When needed, adjust the default light settings for the White Bottom 
Light. Make sure the message given at the bottom of the Hardware 
Interface window is Connected. Click Refresh when necessary. 

4. Click OK and go to the next section.

Arena Settings

note  If you created an experiment with a pre-defined template and 
selected an arena template for DanioVision with the Tapping device 
(DanioVision DVOC 00xx/T, xx wells), the Tapping Stimulus has been 
assigned automatically to the arenas. You can skip the steps below and 
go to the next section. 

1. Open the Arena Settings you want to use.

2. In the Arena Settings pane click Arena - Hardware Mapping and 
then click the Arena - Hardware Mapping button. 

3. Click Add device. 

4. In the new row that appears, under Device type, select Tapping 
Stimulus. 

5. Under A1 or Arena 1 (depending on how the arenas are named), 
select Tapping Stimulus.

6. To test the Tapping Device, select the cell under A1/Arena 1 and click 
Test.

Trial Control Settings

1. Open the Trial Control Settings containing the protocol in which 
you want to insert the Tapping Stimulus. Under Actions - Hardware 
click the button next to Tapping Stimulus.
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2. In the Hardware Action window:

a Enter the Action name.

b Specify the Intensity (0 % to 100 %). 

c Click Test to get an impression of the tap intensity.

d When ready, click OK.

3. Insert the Action box in your Trial Control protocol. 

4. Insert Condition boxes and, when required, Sub-rules to create 
routines. Test the protocol before carrying out the real trials.

important  Allow at least 300 milliseconds between two consecutive 
tapping events. To do so, place a Time condition box that specifies this 
time (> 0.3 sec) between two Tapping Stimulus Action boxes.
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note  If the Tapping Device does not respond to the test action, for 
example after it has not been in use for long time, open the bench plate 
(page 178) and use a screwdriver to gently push the pushpin back, then 
release it so that it hits the metal plate, as if it was activated. Do this a 
few times and then test the action again. Also check the connections 
inside.

Tapping Stimulus Routine

If you have created an experiment from a DanioVision template with 
the Tapping Stimulus Device (DVOC-0050_T), you can find an example 
of a routine with the Tapping Stimulus under Trial Control Settings.

analyze the response to the tapping stimulus

Aim

You can analyze the startle response by looking at dependent variables 
like Activity, Distance moved, or Acceleration (state) immediately before 
and after the administration of the stimulus.

Example

We examine the Total Distance moved in two intervals: (1) a 5-second 
interval immediately before the tapping stimulus command, used as a 
baseline, and (2) a 1-second interval after the tapping stimulus 
command. We expect that the total distance moved increased from 
“before” (assumed to be a baseline) to “after”.

Procedure

1. Open or create a Data profile. 

2. Interval “before”. In the Data profile, under Nesting click the button 
next to Free interval. Define an interval from 5 seconds before the 
action “Tapping Stimulus” was active  to 0 seconds after the action 
“Tapping Stimulus” was active.
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3. Interval “after”. In the Data profile, under Nesting click the button 
next to Free interval. Define an interval from 0 seconds before the 
action “Tapping Stimulus” was active  to 1 seconds after the action 
“Tapping Stimulus” was active.

4. Click the button under Common elements, next to Result . Place the 
Result box under the existing one. Each of the resulting Nest box is 
connected to a separate Results box.
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5. In the Analysis profile define Distance moved.

6. Choose Analysis > Results > Statistics and Charts.
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12 The DanioVision Toplight Unit

This chapter explains the setup and operation of the DanioVision 
Toplight DVTL-0020 for the DanioVision Observation Chamber DVOC-
0050.

With the TopLight Unit you can administer a light stimulus of specific 
color, intensity and duration above the well plate:

 White.

 Pure colors: Red, Green and Blue.

 A mix of the three basic RGB colors.

For the technical specifications, see daniovision toplight unit on 
page 194.

note  The DanioVision Toplight Unit is an add-on to DanioVision; it 
does not come with a standard DanioVision system. 

install the toplight unit

If you ordered a TopLight Unit with a new DanioVision DVOC-0050, it is 
already integrated in the chamber. You can skip this section.

1. Unpack the TopLight Unit.

2. Cover the lens bracket with some protective material.
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3. If that has not been done yet:

a Insert one of the black “stops” into the middle vertical profile, as
shown in the image below.

b Insert one sliding nut just above the “stop”.

Do that at both sides of the DanioVision chamber. 

4. Attach the black knobs to each sliding nut.
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5. Connect the White Light side of the TopLight Unit using the 
predefined black-white cable inside the chamber.

6. Connect the RGB side of the TopLight Unit using the predefined, 
multicolor cable inside the chamber.
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7. Turn the TopLight Unit in such a way tha the LED color that you want 
to use (white vs. RGB) is facing down.

8. Slide the TopLight Unit so that the thread of the black knobs is 
inserted in the side brackets, as shown in the next figure. 

9. Untighten both left and right black knobs to enable the unit sliding 
up and down. 

10.Slide the TopLight Unit up, until it is at the level of the lens.



12 - The DanioVision Toplight Unit 131

11. Make sure that the TopLight Unit is kept horizontal.

12. Tighten the black knobs.

switch between lights (dvoc-0050)

Switch between red, green and blue

If you have DanioVision DVOC-0050 you can create all combinations of 
the three basic colors using the Trial Control Settings. You do not need 
to exchange cable connectors. 

See Trial Control Settings in the section set up the toplight unit in 
ethovision xt on page 134.

Switch between white and colors

If you want to switch from RGB to white light (or vice versa), turn the 
entire TopLight Unit in order to have the right LEDs facing down 
towards the well plate.

The RGB LEDs and white LEDs are mounted on the opposite sides of the 
same plate and can be identified by the label white and rgb attached.

1. Cover the lens bracket with some protective material.
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2. Untighten both left and right round black knobs as shown in the 
next figure.

3. Slide the TopLight Unit down a few centimeter, just below the 
camera.

4. Pull the unit out and turn it upside down, facing the preferred LEDs 
down.

important  Be careful not to twist the cable at the back. Unplug 
temporarily both connectors to prevent this from happening.
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5. Insert the unit and slide it up again.

6. Tighten both black knobs.
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set up the toplight unit in ethovision xt

Experiment Settings

1. Start EthoVision XT and create a new experiment using a template 
(File > New from template). 

2. Choose Setup > Experiment Settings. 

3. Under Trial Control hardware select Use of Trial Control hardware, 
next click Settings. 

4. In the Hardware Interface window, select DanioVision DVOC-0050/
TPC, then click OK.

5. When needed, adjust the default light settings for the White Light 
Stimulus. Make sure the message given in the bottom-left corner is 
Connected. Click Refresh when necessary. 

6. Click OK and go to the next section.

Arena Settings

1. Open the Arena Settings that you want to use. Calibrate and draw 
the arenas.

2. In the Arena Settings pane click Arena - Hardware Mapping and 
then click the Arena - Hardware Mapping button. 

3. If White Top Light/ RGB Top Light is listed in the table, skip the steps 
below. Otherwise, click Add device. 
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4. In the row that appears, under Device type, select either White Top 
Light or RGB Top Light.

5. Under A1 or Arena 1 (depending on how the arenas are named), 
select the corresponding device.

6. To test the device select the cell under A1/Arena 1 and click Test.

Trial Control Settings

1. Make sure you completed the previous procedures described above 
under Experiment Settings and Arena Settings.

2. Open the Trial Control Settings for the protocol you want to use to 
control the TopLight Unit.

3. Under Actions - Hardware click the button next to White Top Light / 
RGB Top Light. 

note  Whether White Top Light or RGB Top Light is available 
depends on what is selected in the Arena - Hardware Mapping 
window.

4. In the Hardware Action window specify:
- The Action name (optional).

- The Action to perform (Light on or Light off).
- For the White TopLight, the Intensity level (%). 
- For the RGB TopLight, you have three Color Intensity options to 

combine the three basic colors. For example to create a strong 
pure red light, enter 100% for Red Color Intensity and o% for the 
other two color intensities. 

- The Fade duration (in ms to hours)
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5. Click Test to ensure that the light intensity is good for your protocol.

6. Click OK and insert the Action box in your Trial Control protocol. See 
program the top lights in ethovision xt on page 136. Test the 
protocol before carrying out the real trials.

program the top lights in ethovision xt

Choose Setup > Trial Control Settings.

example  Program your Trial Control Settings in such a way the White/
RGB Top Light is switched on one minute after the start of the trial. The 
light switches off after 10 seconds.

 Under Conditions, choose Time to create time conditions:
- One Time condition to Wait 1 minute.
- One Time condition to Wait 10 seconds.
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 Under Actions, choose White Top Light / RBG TopLight and define 
the actions:
- One action to switch the White Top Light on.

- One action to switch the Top Light off. This can be done for both 
Output 1 and Output 2 in the Hardware Action boxes.

 Remember to connect all boxes between the Start track action box 
and the Stop track action box.

Create a routine for the Top Light

With the Subrule function of the Trial Control Settings you can create 
routines in order to have the switch on/off sequence repeated multiple 
times. 

For more information, see the EthoVision XT 18 - Trial and Hardware 
Control - Reference Manual.

Also adjust the Detection Settings (Setup > Detection Settings) before 
running the trials.
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Protocols with multi-color light stimuli

You can create a protocol that presents Top Light stimuli of different 
light color within the same trial. To do so:

1. Install the RGB Top Light. Make sure that the RGB side is facing 
down. See Switch between white and colors on page 131.

2. In the Trial Control Settings, create multiple Action boxes. In each of 
them, specify the dominant color and intensity.

3. Insert the Action boxes in the Trial Control Settings procedure. Insert 
Time Condition boxes between subsequent Action boxes. 
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13 The DanioVision Optogenetics 
add-on

introduction

Optogenetics allow scientists to control the activity of specific neurons 
and study their downstream influence on a variety of biological 
processes, including behavior. In rodent behavioral studies, this 
technique requires optical fiber implantation. When working with 
zebrafish larvae, mostly transparent, fiber optics are not needed - light 
simply needs to shine in the right direction, making it easy to assess 
the effect of stimulation of specific, light-sensitive neurons on the 
behavior of the fish.

By inserting light-sensitive receptor proteins into neurons in vivo, it is 
possible to make those neurons sensitive to activation by light of 
specific wavelengths. In zebrafish studies, the light-sensitive receptor 
protein halorhodopsin (NpHR) has successfully been used to inhibit 
swimming behavior in zebrafish larvae (Arrenberg et al. 2009). Other 
research showed that channelrhodopsin-2 (ChR2) activation induced 
backward swimming in a sparse transgene expression line (Zhu et al. 
2009).

Optogenetics add-on

Application of optogenetic stimulation in zebrafish larvae requires the 
correct wavelength (i.e., color) of light. When using the DanioVision 
Observation Chamber, the Optogenetics Add-on provides a way to 
accurately control and precisely time the application of optogenetic 
stimulation to up to 96 individuals simultaneously (working with 96 
well plates).

The Optogenetics add-on for DanioVision is an optogenetic LED light 
source based on the Prizmatix Modular LED system. It consists of one, 
two or three LED wavelengths. The Optogenetics add-on can be 
programmed and controlled using the EthoVision XT software included 
with your DanioVision system. You can set user-defined time 
conditions for the optogenetic stimulation. In comparison to manual 
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control, this offers far better temporal precision and adds efficiency to 
longitudinal studies. 
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Sample experiment

Your DanioVision system comes with an EthoVision XT sample 
experiment: DVOC_Optogenetics_Demo_Recommended.evxt. It 
contains examples of Trial Control rules for triggering pulse sequences 
in one up to three Pulsers.

Additional manuals

 For connecting the hardware: Prizmatix UHP-T LED Illuminator User 
Manual.pdf.

 For programming the Pulser: Prizmatix Pulser User Manual.pdf.

 For connecting the DanioVision Temperature Control Unit: This 
manual, page 80.

install the dichroic mirror in daniovision

If you purchase the DanioVision Observation Chamber DVOC-0050 
with the Optogenetics add-on, the LEDs are already mounted so you 
only have to connect the cables (see the next section). However, the 
dichroic mirror comes in a separate box to prevent damage during 
shipping. This section explains how to install it. Please follow the 
instructions below. 
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note  The function of the dichroic mirror is to direct the color light 
beams to the well plate, and at the same time allow light to reach the 
camera, so you can film and track the fish during the test.

1. Locate the box containing the mirror.

Wear the supplied gloves to avoid damaging or dirtying the mirror. 
Avoid touching the mirror surface and only hold its edges.

2. Locate the arrow on one side of the mirror. Once the mirror is 
mounted, this arrow should be at the top of the mirror and point 
towards the light source, that is, the backside of the Daniovision 
chamber.

3. Attach the mirror (see the next picture). Slide the mirror upwards 
along the brackets as indicated by the arrows.
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4. Position the mirror just above the mark on the right-hand bracket 
(see the picture below, 1). When the mirror is in that position, 
carefully tighten the screw on the left to fix the mirror (2). Do not 
apply any force as this may damage the mirror.

5. The mirror is now ready to use. See the next sections.

important  The LED is extremely powerful and may cause eye injury 
when looking directly into the light source. For testing, we recommend 
to set the LED intensity to low.

the pulser software

Please skip this section if you do not use the Pulser/PulserPlus devices.

Follow the procedure below if you use one or more Pulser/PulserPlus 
devices. To control multiple devices, multiple instances of the Pulser 
software must be running on the EthoVision XT computer.

important  Do not connect the Pulser/PulserPlus device to the 
computer until the software setup process is complete.

Install the Pulser software once

1. Copy the installation files and folders to your computer’s hard 
drive.
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2. Run the setup.exe file and follow the instructions as they appear on 
the screen. Next, restart the computer to complete the software 
installation.

3. Open the folder where the software has been installed (default: 
C:\Program Files (x86)\Prizmatix Pulser Plus 3.2.1) and make a 
shortcut to the EXE file. Give the shortcut a name that is easily 
recognized, like Pulser A or the name of the first LED.

4. To install or update the Pulser/PulserPlus drivers, see the Pulser/
PulserPlus User Manual.

Install multiple instances of the Pulser software

To control two or three LEDs independently using the dedicated Pulser/
PulserPlus devices, install one instance of the Pulser software for each 
Pulser/PulserPlus.

1. Install the first instance of the Pulser software (see above).

2. Browse to the folder C:\Program Files (x86) and copy the entire 
folder Prizmatix Pulser Plus 3.2.1.

3. Paste the folder in the same location C:\Program Files (x86). 
Rename the folder to Prizmatix Pulser Plus 3.2.1 PulserB.

4. Open the new folder and make a shortcut for the EXE file that you 
find there. Place the shortcut on your desktop. Name it like Pulser B 
or the name of the second LED.

5. If you have a third LED, repeat the steps above from 2 to 4 to create a 
new folder which will contain a third instance of the Pulser software. 
Make a shortcut to the new EXE file and rename it to e.g. Pulser C. 

6. You should at this point have a folder structure like the following:

and three shortcuts on your desktop.
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led controller uhptlcc

This device has a switch in the middle of the front panel.

Basic connections

1. Make sure the power switch (1) is set to Off.

2. Connect the 12VDC connector (10) to the power outlet through its 
power cable and adapter.
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3. Connect the LED cables (LED Control cable and LED Current cable) 
that come from the DanioVision system to the two LED connectors 
(8 and 9, respectively).

To control the LED manually:

1. Set the switch near TTL (5) to Int.

2. Set the switch near Ain (6) to Int.

3. Turn on the main power (see 1 in the figure above).

4. To turn the LED on, flip the switch (2) on.

To control the LED from EthoVision XT through TTL

1. Set the switch near TTL (5) to Ext.

2. Set the switch near Ain (6) to Int.

3. Turn on the main power (see 1 in the figure above).

4. To turn the LED on, flip the switch (2) on.

5. Connect the TTL cable with BNC connector from the pulser (or the 
back of the DanioVision chamber, depending on the setup) to the 
TTL connector on the back panel of the LED controller (4).

6. In EthoVision XT you can now give the “high” command using the 
Trial Control actions. See page 157 or 159 depending on the setup.

Other controls

 Power adjustment dial (3).

 Analog input (Ain) connector (7).



146  13 - The DanioVision Optogenetics add-on

led controller uhptlcc-02

This device does not have a switch in the middle of the front panel.

Basic connections

1. Make sure the power switch (9) is set to Off (O).

2. Connect the 12VDC connector to the power outlet through the 
power cable and adapter. 
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3. Connect the LED cables (LED Current cable and LED Control cable) 
that come from the DanioVision system to the two LED connectors 
(7 and 8, respectively).

To control the LED manually:

4. Set the switch near TTL (4) to Int.

5. Set the switch near Ain (5) to Int.

6. Turn on the main power  (9).

7. To turn the LED on and off, press the button (1).

To control the LED from EthoVision XT through TTL

1. Set the switch near TTL (4) to Ext.

2. Set the switch near Ain (5) to Int.

3. Turn on the main power (9).

4. Do one of the following, depending on whether you work with 
Pulsers or not.
- If you do not use the Pulsers, connect the TTL-In of each LED 

controller to the connectors at the back of DanioVision: Trigger 
Out 1 for LED Controller 1,  Trigger Out 2 for LED Controller 2, and 
TTL A (or B) for LED Controller 3. For this latter connection you 
need a special cable with a 8-pin connector at one end and a 
BNC connector at the other end. See configuration 2 - with the 
pulsers on page 149.
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- If you use the Pulsers, connect the Trigger In of each Pulser to 
the connectors at the back of DanioVision: Trigger Out 1 for 
Pulser A,  Trigger Out 2 for Pulser 2, and TTL A (or B) for Pulser C. 
For this latter connection you need a special cable with a 8-pin 
connector at one end and a BNC connector at the other end. See 
configuration 2 - with the pulsers on page 151.

5. In EthoVision XT you can now trigger the LED controllers or the 
Pulsers using the Trial Control actions. See page 157 or 159 depending 
on the setup.

Other controls

 Power adjustment dial (2), Analog input (Ain) connector (6).
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configuration 1 - without the pulsers

In the following example, EthoVision XT controls three LED controllers 
through the TTL ports in the DanioVision Observation Chamber.

Connection diagram
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EthoVision XT connections

 One Ethernet connection to control the DanioVision and 
Optogenetics hardware devices.

 One Ethernet connection for the DanioVision camera. See page 14.

Next steps

 experiment settings on page 153.

 arena settings on page 154.

 trial control (without the pulsers) on page 157.

For information about creating pulse sequences in EthoVision XT, see 
the Chapter Optogenetics experiments in the EthoVision XT 18 - 
Application Manual. To open this manual, from the Windows Start 
menu choose All Apps > Noldus > EthoVision XT 18 Other 
Documentation.
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configuration 2 - with the pulsers

Connection diagram
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TTL lines

 If you use one Pulser, use the DanioVision Trigger out 1 port to 
connect the Pulser.

 If you use two Pulsers, use the DanioVision Trigger out 1 port and 
the Trigger out 2 port to connect the Pulsers A and B, respectively.

 If you use three Pulsers:
- Use the DanioVision Trigger out 1 port for Pulser A.
- Use the DanioVision Trigger out 2 port for Pulser B.
- Use the DanioVision TTL A port (if it is not connected to the 

Temperature Control Unit) or the TTL B port for Pulser C. For the 
TTL A/B connection you need a special cable with a 8-pin 
connector at one end and a BNC connector at the other end.

EthoVision XT connections

 One Ethernet connection for controlling the DanioVision and 
Optogenetics hardware devices.

 One Ethernet connection for the DanioVision camera. See page 14.

Next steps

 experiment settings on page 153.

 arena settings on page 154.

 trial control (with the pulsers) on page 159.

For information about creating pulse sequences in EthoVision XT, see 
the Chapter Optogenetics experiments in the EthoVision XT 18 - 
Application Manual. To open this manual, from the Windows Start 
menu choose All Apps > Noldus > EthoVision XT 18 Other 
Documentation.
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experiment settings

1. Choose Setup > Experiment Settings. 

2. Click Settings next to Use of Trial Control hardware. 

3. Choose the DanioVision DVOC-0050/TCP. Then follow the section 
below that applies to choose the port numbers in the Device 
Configuration window.

tip  Open the sample experiment DVOC_Optogenetics_Demo_ 
Recommended.evxt***. This is a live tracking experiment where basic 
settings in Experiment Settings and Trial Control are already selected 
for when you work with three pulsers.

Configuration without Pulsers

In this example with three LED controllers, we use the connectors 
Trigger out 1, Trigger out 2 and TTL B because TTL A is connected to the 
DanioVision TCU.

 Trigger out 1 and Trigger out 2 (both included in Trigger out in the 
figure below) are connected to the LED controllers 1 and 2. Select 
Optogenetics next to Trigger Out. 

 TTL Port B is connected to LED controller 3. See the scheme on page 
149. Select Custom Hardware under Device Type.
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Configuration with the Pulsers

In this example with three Pulsers, we use the connectors Trigger out 1, 
Trigger out 2 and TTL B because TTL A is connected to the DanioVision 
TCU.

 Trigger out 1 and Trigger out 2 (both included in Trigger out in the 
figure below) are connected to the Pulser A and Pulser B, 
respectively. Select Optogenetics next to Trigger Out. 

 TTL Port B is connected to Pulser C. See the scheme on page 151. 
Select Custom Hardware under Device Type.

arena settings

Declare the Optogenetics setup

The figures below refer to a configuration with three Pulsers.

1. Choose Setup > Arena Settings. Draw and calibrate the arenas (see 
this manual). 

2. Click the Arena - Hardware Mapping button. 

3. Click Add device.
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4. In the new row, under Device type select Optogenetics (for Pulser A 
and B, or LED controllers 1 and 2).

5. Click Add device.

6. In the new row, under Device type select Custom Hardware (for 
Pulser C, or LED controller 3).

tip  Rename Device name to the actual name of the controlled 
devices, for example Pulsers A and B and Pulser C for the two rows, 
respectively. If you work only with LED controllers, type in for 
example LED 1 and 2, and LED 3, respectively.

7. Make sure that the devices are selected under A1/Arena 1.

Test the triggering action on the LED controllers

1. In EthoVision XT, open the Arena - Hardware Mapping window (see 
page 154). 

2. Click the row for the pulser you want to test (either LED 1 and 2 or 
LED 3).

3. Click the Test button.
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4. In the window that appears:
- If you have selected LED 1 and 2 in the steps above, select Output 

1 High to trigger the LED connected to Trigger out 1 on the 
DanioVision’s back panel (this is usually LED 1), or select Output 
2 High to trigger the LED connected to Trigger out 2 (this is 
usually LED 2). 

- If you have selected LED 3 in the steps above, select Output 1 
High to trigger the LED.

5. Click Test. At this point the LED switches on. If it does not, do the 
following:
- Check carefully the cabling. 
- Check that the green button on the LED controller is turned on.

6. Next, see trial control (without the pulsers) on page 157.

Test the triggering action on the Pulsers

1. important  Make sure that in the Pulser software the correct COM 
port is selected and that the operating mode is set to (3) Execute 
sequence after trigger HIGH, then stop when LOW.

2. Next, click the button Start sequence. Now the Pulser is listening to 
the trigger signal.

3. In EthoVision XT, open the Arena - Hardware Mapping window (see 
page 154). 

4. Click the row for the pulser you want to test (either Pulser A and B or 
Pulser C).

5. Click the Test button.

6. In the window that appears, select Output 1 High or Output 2 High, 
depending on which Pulser you want to test: 
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- If you have selected Pulser A and B in the steps above, select 
Output 1 High to trigger the Pulser connected to Trigger out 1 on 
the DanioVision’s back panel (this is usually Pulser A), or select 
Output 2 High to trigger the Pulser connected to Trigger out 2 
(this is usually Pulser B). 

- If you have selected Pulser C in the steps above, select Output 1 
High to trigger the Pulser.

7. Click Test. At this point the LED connected to that Pulser is activated 
following the sequence defined in the Pulser software. If it is not, do 
the following:
- Check carefully the cabling. 
- Check that the Start sequence button was pressed.
- Check that the green button on the LED controller is turned on.

8. Next, see trial control (with the pulsers) on page 159.

trial control (without the pulsers)

Prerequisites

 The dichroic mirror is installed (page 140). 

 All components are connected (page 149) and powered up.

 The LED controllers are set to TTL control (page 144).

Procedure

To control the LED directly from EthoVision XT, program the Trial 
Control rule using Action boxes. The duration of the light pulse is 
determined by a Time condition placed between the Action Output 1/2 
High and Output 1/2 Low.



158  13 - The DanioVision Optogenetics add-on

In the example below, LED 1 (named Device D in the Arena - Hardware 
mapping window) is activated with a TTL signal Output 1 High and after 
0.5 it is deactivated with a TTL signal Output 1 Low. See page 149 for the 
connections.

The sequence Action - Time condition - Action has been placed within a 
Sub-rule (defined here below by the boxes with blue titles), so that it 
can be repeated a number of times.

Notes

 Use Output 2 High/Low commands to control the LED controller 
connected to the DanioVision Trigger out 2 port.

 Make sure that the Int-Ext switch near TTL on the LED controllers is 
set to Ext!
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trial control (with the pulsers)

Prerequisites

 The dichroic mirror is installed (page 140).

 All components are connected (page 151) and powered up.

 The LED controllers are set to TTL - Ext control (page 144).

Procedure

1. Open all the instances of the Pulser software by clicking on the 
desktop shortcuts Pulser A, Pulser B, and Pulser C. Each instance 
controls one pulser.

2. For each instance of the software, next to Select COM port, choose 
the correct COM port for the corresponding Pulser. These can be 
found on the pulser or on the connection diagram.

3. Next to Select Operation Mode, choose one of the following:
- When testing the Pulser, choose (0) Execute pulse sequence 

after START. By pressing the Start Sequence button, the LED 
flashes the configured sequence. 

- When running the actual trials, choose (3) Execute pulse 
sequence after trigger HIGH, then stop when LOW. If you now 
click the Start Sequence button, the Pulser waits for a TTL trigger 
from EthoVision XT to start the sequence.

4. Enter the other settings in the dialog to control the pulse duration 
and the time between pulses. For details, see the Prizmatix Pulser/
PulserPlus User Manual.

5. Start EthoVision and open the example experiment: 
DVOC_Optogenetics_demo_recommended.evxt
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6. In the Trial Control Settings, you find predefined routines (called 
subrules) to control three Pulsers. The main procedure (top row) has 
been configured to consecutively trigger the three Pulsers using the 
corresponding subrules. Make sure that: 
- The pulsers all have the correct COM port.
- The Pulsers are all in mode 3 .
- The Start Sequence button has been pressed. 

- See also configure the com port for each pulser on page 163.

Here below you find the basic actions to control the triggering of 
the Pulsers. For more information, see also the Chapter 
Optogenetics experiments in the EthoVision XT 18 - Application 
Manual.

Basic subrule

A set of instructions within a subrule activates the Pulser a number of 
times, as specified in the Subrule Reference box.

The three boxes within the subrule specify:

 An action that triggers the pulse sequence (Send a High signal to a 
device through line Output 1 or Output 2).

 A Time condition to wait a number of seconds.

 An action that stops the pulse sequence (Send a Low signal to a 
device through line Output 1 or Output 2).

In the following example, the subrule triggers the sequence in the 
Pulser A through the Output 1 line, for 5 seconds. 



13 - The DanioVision Optogenetics add-on 161

The settings of the two actions are as follows:

Notes

 The name of the device selected next to Optogenetics has been 
renamed to 570 +520 nm in the Arena - Hardware Mapping window. 
This because it controls two Pulsers, one for a LED of 570 nm 
through line Output 1 (from the Trigger out 1 port in DanioVision) 
and one for a LED of 520 nm through line Output 2 (from the Trigger 
out 2 port in DanioVision). In this example we operate the first 
Pulser only, using the command Output 1 High. 

 You find the name 570 +520 nm in the Arena - Hardware Mapping 
window of the Arena Settings in the demo experiment. 

 Do not forget to set the Int-Ext switch located near TTL on the LED 
controller to Ext!
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acquire the data

To acquire the data, choose Acquisition > Open Acquisition.

Important things to check

 Make sure that the green light of the button on the LED controller is 
switched on.

 Make sure that the Pulser software is open on your screen. There 
must be one instance of Pulser software for each Pulser. S if you 
work with two Pulsers simultaneously, two Pulser sofware 
windows must be open. See Install multiple instances of the Pulser 
software on page 143.

 Check that each instance of the Pulser software indicates that a 
COM port is selected (COM3, COM4, etc.) and shows the message 
Prizmatix Pulser is connected. 

 If you use the Pulser in trigger mode, in the Pulser software check 
that the Operating Mode is set to (3) Execute sequence after trigger 
HIGH, then stop when LOW. Next, click the button Start sequence. 
Now the Pulser is listening to the trigger signal.

Start the trial

To start the trial, click the Start Trial button. The optogenetics setup 
will be activated according to the Trial Control protocol that is active at 
that time. For more information, see Acquire data on page 76.
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configure the com port for each pulser

Aim

To configure the COM port in such a way the Pulser/PulserPlus accepts 
commands from EthoVision XT.

Procedure

1. Connect the Pulser/PulserPlus to the PC using the USB cable with 
type-A to type-B connectors.

2. In the Control Panel, open the Device Manager.

3. Under Ports (COM & LPT), right-click USB Serial Port and select 
Properties.

4. Click the Port Settings tab.

5. Make sure that the parameters are as below, then click OK.
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6. Take note of the port number (in the example above it is COM3).

7. Repeat the procedure for each Pulser/PulserPlus.

Notes

 The COM port number is retained in the Pulser, so if you disconnect 
the Pulsers and reconnect them, you do not have to assign the COM 
ports again.

 tip  To know which COM port is assigned to which Pulser/PulserPlus 
device, disconnect the USB cable from one Pulser/Pulser Plus. Then, 
re-connect it. The item that appears under Ports (COM & LPT) 
indicates the COM port.

 tip  To change the COM port for a specific Pulser, in the Control 
Panel, open the Device Manager. Under Ports (COM & LPT), right-
click the COM port, select Properties, Port Settings, then Advanced. 
From the COM Port Number list select the COM port among those 
available.
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14 Data preparation

smooth the tracks

Track Smoothing profiles in the template experiment

 No Smoothing. Smoothing filters are not activated.

 MDM 0.2 mm - With this Minimal Distance Moved filter, you can 
reduce the effect of ‘jitter’ on the Distance moved variable. 
Applying this filter is recommended, however, it results in longer 
calculation times in the analysis.

Change these settings for your setup, if necessary.

More options

Use the Maximum Distance Moved filter to remove outliers in the 
track, due to erratic detection of objects within the arena. when the 
margin of the well is sometimes detected as the fish.

For more information on smoothing data, see Smooth the Tracks in the 
EthoVision XT Help.

select data

Data profiles in the template experiment

 All Data. With this Data profile you analyze all tracks separately.

 Treated vs. Control - The data are split for analysis based on the two 
values of the user-defined variable Treatment: Treated and Control.

This Data profile assumes that you have assigned a label (either 
Control or Treated) to each of yout trials or arenas (wells).



166  14 - Data preparation

Analyze dark vs. light periods

In this example, the researcher wants to analyze the data in different 
light and dark periods, determined by the activation of the white light. 
In the Data profile, the function Trial Control State under Nesting is 
used to create intervals corresponding to the state of the white light. 

1. Choose Analysis > Data Profile > New. Give the new Data profile a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Trial Control State.

3. Select the period you are interested in, using the Trial Control 
actions. For example From Light On To Light Off (depending on what 
name the Light On/Off actions have in the Trial Control Settings).

4. Insert the Nest box in the Data profile sequence.

5. If you want to analyze different periods and have the results in the 
same table, create more Results boxes as shown in the picture 
below. To add a Result box, in the Components pane click the button 
next to Result. In each sequence, add a Nest box that specifies a 
different Trial Control State.
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6. Choose the dependent variables and run analysis (see page 172).

tip  See also the sample experiment DanioVision with 96 wells XT 
which you can download from our web site (see page 10). There you can 
find the Data profile mentioned here.

Analyze data excluding periods of inactivity

In this example we want to exclude the interval in which a larva was 
not moving.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Movement.

3. In the Movement tab, you can set the following:
- Averaging interval (range 1 - 1000) – This is the number of 

samples across which changes in speed are calculated to 
determine whether the subject is moving or not. In order to 
reduce the sensitivity of the Movement variable to brief changes 
in velocity, the velocity data can be smoothed by taking the 
running average of the last n samples. Enter the averaging 
interval n or leave 1 if you do not want to smooth the velocity 
data.

- Start velocity – The velocity above which the subject is 
considered to be moving.
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- Stop velocity – The velocity below which displacements of the 
subject’s body points are no longer attributed to locomotion but 
to system noise, body wobble or pivoting on the spot.

4. Under Calculate nesting for, select Not moving.

5. Click OK. Insert the Nest box in the appropriate position between 
the Start and the Result box.

6. Choose the dependent variables and run analysis (see page 172).

For more information on the Nesting functions, see Analyze Track 
Segments in the EthoVision XT Help.

Analyze the intervals around the onset of the white light

In this example, we want to analyze two intervals:

 From 5 seconds before the onset of the White light stimulus, to the 
onset of the stimulus.

 From the onset of the White light stimulus, to 5 seconds after the 
onset of the stimulus.

The aim is to compare activity, speed and other parameters between 
the two intervals.

1. Choose Analysis > Data Profile > New. Give the new Data profile a a 
name and click OK.

2. In the Components pane, under Nesting, click the button next to 
Free interval.

3. Do the following:

Under Start criterion, select Trial Control. Choose the options as in 
the picture below.
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Under Stop criterion, select Time. Next to Elapsed time leave 
0:00:00.000 after start event selected. 

note  The term start event refers to the White light selected under 
Interval start.

Click OK and insert the Nest box in the sequence.

4. To create the second interval, choose first Result under Common 
elements. Click the middle of the Start box and drag to the Result 2 
box; this will connect the two boxes.
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5. Repeat the steps 2-3 to create a new Nest box, this time for the 
interval “from White light to 5-s after that”. In the settings, choose 
the criteria for the second interval: from “Trial Control - 0 seconds 
before Action: Light on” to “Time - Elapsed time 5 seconds after start 
event”.

Click OK and insert the Nest box in the sequence.



14 - Data preparation 171

6. Choose the dependent variables and run analysis (see page 172).

tip  Click Settings in the Result boxes and rename them, to for example 
5-s Before white light and 5-s after white light. Those names will be 
displayed as headers in your results.
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15 Analyze DanioVision data

analysis profiles and options

Analysis profiles in the template experiment

 Distance, Time & Movement - Contains the dependent variables 
Distance moved, Velocity and Movement.

 Path Shape - Contains the dependent variables Heading, Turn 
angle, Angular velocity and Meander.

 Rotation - Contains two instances of the dependent variable 
Rotation, to count the number of clockwise and counterclockwise 
rotations.

For more information on these and other dependent variables, see 
Dependent Variables in Detail in the EthoVision XT Help. Also see the 
chapter Analysis of Trial Control data in the EthoVision XT 18 - Trial and 
Hardware Control - Reference Manual.

Analyze intervals

Make sure you have defined a Data profile which specifies the intervals 
you are interested in (see page 165). Next, in the Analysis profile choose 
your variables (e.g. Distance moved). Then visualize the data (see an 
example in Figure 14) and run analysis (see page 176).

Activity analysis

You can also use the dependent variable Activity state. This variable is 
only available when you selected Activity analysis in the Experiment 
Settings (see page 46 and page 74). 

With Activity state you can calculate how long and how frequent your 
subject has been in different activity states. These states depend on the 
total pixel change within the arena between a sample and the previous 
sample. It is important that all defined arenas have exactly the same 
size. The number of states (two to four) and their thresholds are user-
defined.
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Analyze convulsions

To analyze convulsions, you can use several variables, such as Velocity, 
Movement, Activity and Mobility.

Method 1 - With Movement. In this example, seizures are frequently 
characterized by fast zig-zag movements that last up to two seconds. 
To discriminate between seizure and no seizure, we use Movement, a 
variable based on the current (smoothed) velocity of the fish.

Figure 14  Example of visualization of data after nesting over a Trial Control 
State. Here the samples of Arena 1 are displayed in full color when the white light 
was on. Only those samples are subject to analysis. The first plot is of the variable 
Trial Control State (defined as: From Light on to Light off; it illustrates the effect of 
nesting), and the second is of Distance moved defined in the Analysis profile.
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1. Create an instance of Movement that is active when the velocity 
exceeds a specific threshold value. To get an idea of what the 
threshold should be, plot the values of velocity with an averaging 
interval of 5. Play the video until a seizure occurs in one of the wells, 
and look at the values of velocity for that subject. In this example, 
velocity is higher than 15 mm/s in this example. Check this in other 
wells and in a few videos and try to find an optimal cut-off value.

2. Create a Free interval that has the following settings:
- Start Criterion: Dependent Variable; Select Variable: Movement. 

Set Movement with a Start velocity threshold around 1.5 cm/s 
and a Stop velocity threshold a bit lower (say 1.3 cm/s). Select 
Statistic: Current Duration of Moving and choose a value like >= 
0.5 s. This way you filter out short swim burst that are less likely 
to be seizures.

3. Stop Criterion: same as above, with the difference that you select 
Current Duration of Not Moving >= 0.5 s. The free interval ends 
when the fish has been Not Moving for half a second. 

4. The resulting free interval captures the period of time when the 
velocity of the subject is higher than the threshold value.
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tip  To exclude sudden changes in velocity in the middle of a seizure, 
use an Averaging interval when defining Movement.

5. Calculate the necessary statistics, like the average duration of the 
seizures, the number of occurrences, etc.

Method 2 - With Mobility. Create a Mobility variable in your Analysis 
profile. Start with setting a High Mobility Threshold to a high value like 
95%, and an averaging interval of 2. Similar to Movement, Mobility 
should only capture the periods of the time when the subject is very 
active because of the seizure, excluding normal swimming activity. 
Compare the scores of Highly Mobile with those of convulsions 
obtained manually. Adjust the mobility thresholds until they match.

heatmaps

To create a heatmap of the subjects’ position, choose Analysis > 
Results > Plot Heatmaps. Choose the Data profile from the list on the 
toolbar to create a heatmap based on the data selected. 

Figure 15  Example of visualization of heatmaps in the sample 
experiment DanioVision with camera zoomed into four wells.
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Notes

 There is one scale for all the wells in the well plate. You cannot 
create separate scales for each well, unless you select single wells in 
the Data profiles (one well for each Results box).

 For DanioVision experiments, the Group Means button is not 
available.

 For more information on heatmaps, open the EthoVision XT Help 
and browse to Visualize data > Plot heatmaps.

calculate the statistics

Procedure

1. Choose Analysis > Analysis Profile > New.

2. Add the dependent variables of your interest (see the section 
analysis profiles and options on page 172). For an overview, see 
Dependent Variables in Detail in the EthoVision XT Help.

3. In the Trial Statistics tab, choose the statistics you want to calculate 
per trial for that variable. If you created groups of tracks in the Data 
profile, select additional statistics in the Group Statistics tab. 

4. Repeat steps 2-3 to add more dependent variables.

5. Choose Analysis > Results > Statistics & Charts. Choose the Data 
Profile from the list on the tool bar and click the Calculate button.

6. The results appears on the screen. The Trial Statistics tab shows the 
statistics per trial. The Group Statistics & Charts tab shows the 
statistics and charts from the summarized results of all trials. See 
Calculate Statistics in the EthoVision XT Help for details.

7. optional  Click the Layout button and change the layout of the 
results table.

Batch calculations

It is also possible to carry out multiple analyses with different filters, 
data profiles and analysis profiles. To do so click the Batch button.
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Make your selection from the lists under Select the profile 
combinations to calculate and click Add. When done, click Calculate. To 
view a specific analysis result, select the options from the lists on the 
toolbar. For more information on batch statistics calculation, see Batch 
statistics calculation in the EthoVision XT Help.
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A Open the DanioVision casing

tools that you need

A Phillips or (preferably) a Pozidrive 
screwdriver, size 2.

Do not use electric screwdrivers!

bench plate

Remove the bench plate, for example, to 
install the Tapping Device and other, 
custom hardware you want to place 
inside the DanioVision Observation 
Chamber.

Also when opening the top casing (page 
179) it is handy to first remove the bench 
plate.

1. Remove the four screws as indicated in the picture below.

2. Remove the bench plate.
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top casing

Remove the top casing, for example, when 
you need to replace the camera.

1. optional  Remove the bench plate first (page 178), this makes the 
following steps easier.

2. Remove the eight screws as indicated in the picture below. 

note  The screws located more internally are shorter than the 
others. Take note of which screw goes to which hole, for when you 
put everything back in its place.
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3. Close the lid and lift the top casing.

4. When putting the top casing back in place, make sure that you insert 
the sides into the bottom casing as indicated in the next picture.

5. Tighten all the screws.
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sides and back casing

Remove the sides and back casing to 
access the connector box, wirings and 
internal tubings. In most cases you do 
not need to do so.

1. Follow the instructions on page 179 to remove the top casing.

2. Put the DanioVision Observation Chamber just over at the edge of 
the table and remove the three screws from the bottom plate. 

Just remove the three screws that are nearest to the side of the 
DanioVision chamber. Do not remove the other screws. 

3. Repeat the previous step for the other side.
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4. Remove the two screws at the back as indicated in the picture below.

5. You can now lift the casing.
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remove the connector panel

To remove the connector panel at the back of the observation chamber, 
remove the four screws as indicated in the picture below.

adjust the lid friction

You can adjust the friction of the Observation chamber lid. 

If the lid falls down easily or opens with much friction, loosen or 
tighten the three screws per hinge, respectively. 
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B Fine camera adjustments

Each DanioVision system is thoroughly checked and set to its optimal 
configuration. However, transport and handling of the system may 
sometimes cause slight changes in the camera position relative to the 
well plate, resulting in a sub-optimal video image. This section helps 
you restore the original settings. To open the DanioVision casing, see 
page 178.

center the well plate horizontally

Follow these steps if the well plate is not centered horizontally:

1. Loosen the washer located behind the camera bracket, under the 
camera profile. 
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2. Turn the camera in the direction required until the well plate is in 
the middle of the camera view.

3. Tighten the washer to fix the camera in the new position.

center the well plate vertically

If the camera is rotated forward or backward in its vertical plane, the 
video image may look like this:

1. Loosen the two bolts at the sides of the camera profile.
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2. Rotate the camera bracket forward or backward until the well plate 
is centered vertically in the video image.

3. Tighten the bolts.
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if the well plate looks rotated

Follow the steps below if the margin of the well plate is not parallel to 
the margin of the video image:

1. Open the DanioVision Observation Chamber and locate one of the 
bolts at the side of the camera profile (either left or right):

2. Loose the bolt using a 3-mm Allen key.

3. Gently move the camera bracket forward or backward until the well 
plate is in the correct orientation. When ready, tighten the bolt.
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example of a good video image

Check that the well plate fills the video image as much as possible, 
with the letters A-H and numbers 1-8 well visible. 

Set the camera lens to maximum aperture. The image is overexposed 
when no water is present. 

Below an example of a good video image when water is present:

Tighten the three screws on the camera lens once the image is 
optimized.
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C System specifications

daniovision dvoc-0050

Dimensions

 61 x 32 x 46 cm (24 1/64” x 12 19/32” x 18 7/64”) (h x w x d) in closed 
position

 Door opening 36 x 29 cm (14 11/64” x 11 27/64”) (h x w)

Weight

 15 kg excluding power supply, external tubes and cables

Power supply

 Power requirements: 24 Volt DC, 4.0 A (max).

 Mains adapter: input 100-240 Volt AC, output 24 Volt DC, ***4.0 A.

Camera

 Brand, type: Basler acA1300-60gm

 Interface: Gigabit Ethernet (RJ45 connector, CAT5e or higher)

 Sensor: 1/1.8” Progressive Scan CMOS, monochrome

 Max. resolution: 1280 x 1024

 Max. frame rate: 60 fps

Lens

 12 mm 2 Megapixel, C-mount, F1.4, includes IR pass filter

 Optional lens: 8 mm 2 Megapixel, C-mount, F1.4, includes IR pass 
filter. 

note  For this lens you need a 0.5 mm spacer ring.
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Video performance (H x V pixels)

 Default: 1280 x 960 at 30 fps (in combination with 12 mm lens)

 Optional: 
- 640 x 480 at 60 fps (in combination with 12 mm lens)
- 800 x 600 at 60 fps (in combination with 8 mm lens)

Maximum frame rates as measured in a 96 well plate setup.

Backlight unit

 Combined infrared (IR) and white light (White Light Stimulus) array.

 Infrared wavelength (typical): 950 nm.

According to published research, zebrafish are sensitive to infrared 
light, though not above 910 nm. See Shcherbakov et al. 2013, PLoS 
ONE 8(5): e64429. The IR light provided by DanioVision is therefore 
unlikely to affect the fish’s behavior.

 White light color temperature (typical): 5500ºK.

 White light level controllable with EthoVision XT. 

Intensity range: 
- Standard levels: 0 to ±10000 lux.
- Low Light levels (Low Light switch set to L): 0 to about 20 lux. 

Light level measured directly at the bottom of the water basin.

For details, see configure the daniovision white bottom light on 
page 36.

Multi basin

 Water inlet, water outlet and overflow.

 Basin size 158 x 132 mm (6 7/32” x 5 13/64”).

 Supports ANSI, SBS compatible micro plates (L =127.76± 0.5 mm 
(5 1/32” ± 1/64”), W=85.48 ± 0.5 mm (3 23/64” ± 1/64”) with 
maximum height of 27mm (1 1/16”).

 Supports Petri dishes up to 90 mm (3 35/64”) in diameter.
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 Temperature sensor supporting the use of Noldus DVTCU 
(Temperature Control Unit).

Water connections

 Water inlet/outlet: tube fitting 8 mm.

 Water overflow: tube fitting 10 mm.

Tubes included

 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water inlet (green color 
marked).

 1.5 m Clear PVC Hose, 8 mm OD, 5 mm ID for water outlet (yellow 
color marked).

 1.5 m Clear PVC Hose, 10 mm OD, 8 mm ID for water overflow (red 
color marked).

PC interface

 Ethernet.

External I/O

 TTL input/output (2x modular RJ45 connector): 2x 2 TTL input, 2x 2 
TTL output.

 TTL Trigger Out (2x BNC connector): 2x TTL output.

System start-up time (cold start)

 ~ 15 minutes.

Cleaning the DanioVision Observation Chamber

 Outside of the chamber: We recommend to use a propriety glass-
cleaning fluid or a detergent solution to clean the outside of the 
DanioVision Observation Chamber.

 Inside parts (Fresnell lens, lens heater, etc.): Only use a damp cloth 
dipped in a mild detergent solution with warm/lukewarm water. 
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Use a micro fiber cloth, so that the cloth is just damp and leaves no 
droplets on the surface.

Declaration of conformity

See page 196.

daniovision temperature control unit (tcu)

Dimensions (L x W x H)

 460 x 210 x 280 mm/ 18” 11 x 8” 26 x 11” 02.

 Hose connectors 8 mm outer diameter tube.

Weight

7 kg / 15.43 pound.

Electrical

 Operating voltage: 24 V DC.

 Power consumption (Average / Maximum): 40 / 120 W.

 TTL port specs: 2 input / 2 output, Max. 5 V / Max. 5 V, open 
collector.

Operational

 Temperature accuracy: ± 0.5 °C / ± 0.9 °F.

 Temperature set point range: 15 - 40 °C / 59 - 104 °F.

 Maximum heating capacity: At least 10 °C / 18 °F above ambient 
temperature (within the temperature set point range 15-40 °C / 59-
104 °F).

 Maximum cooling capacity: 2.5 °C / 4.5 °F below ambient 
temperature (within the temperature set point range 15-40 °C / 59-
104 °F).

 Permissible water temperature range: 5 - 50 °C / 41 - 122 °F.
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 Water capacity: ± 350 ml / ± 11.83 oz.

 Pump flow rate – water: ± 310 ml per min / ± 10.48 oz per min.

 Water filter type: 20 μm pore size, 1 inch diameter.

 Cooling liquid capacity: ± 250 ml / ± 8.45 oz.

 Cooling liquid type: Colored, anti-corrosive, anti-algae, PC-type 
cooling liquid.

 Pump flow rate – cooling liquid: ± 1650 ml per min / ± 55.79 oz per 
min.

 Maximum height difference DVOC and TCU: 1.3 m / 4.26 ft.

important  Do not place the Temperature Control Unit higher than 
the Observation Chamber!

 Noise level: Average over all frequencies < 35 dB; Max. peak of ±48 
dB around 160 Hz.

Environmental conditions

 Permissible ambient temperature range: 
- Operating: 10 - 35 °C / 50 - 95 °F.
- Storage: 5 - 65 °C / 41 - 149 °F.

 Permissible relative humidity: 20% - 80% (non-condensing).

daniovision tapping device

Dimensions

 Tapping Device (including aluminum bracket): 6 x 24 x 7.5 cm /
(2 23/64” x 9 29/64” x 2 61/64”) (h x w x d).

 Control box: 2.5 x 10 x 6.5 cm (63/64” x 3 15/16” x 2 9/16”) (h x w x d).

Weight

 ~ 300g (Tapping Device, bracket, control box).
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 If not pre-assembled in the DVOC-0050, the package includes 
mounting material.

Power

 Power requirements: 24 V DC, 0.4 A (max).

Features

 Controlled from EthoVision XT 10.1 or later with selectable stimulus 
intensity (1-8).

 Delivers a discrete ‘tap’ to the well plate holder.

 Maximum tapping rate of ±3 taps per second.

Connectors

 Molex 2 pin – Power (24 V).

 Molex 4 pin – From Tapping Device to control box.

 Multi connector (blue) – For TTL control signal.

Compatible DanioVision Chambers

 DVOC-004x, DVOC-0050.

daniovision toplight unit

Dimensions

270 x 220 x 30mm   (10 5/8” x 8 21/32” x 1 3/16”).

White light

 > 30.000 lux at 25cm distance (well plate), 1584 lm.

 Color temperature 4000 °K.

 Array of 408 LEDs.

 Max. voltage 18 V.
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Red light

 192 lm, wavelength 623 nm.

 Array of 252 RGB LEDs.

 Max. voltage 24 V.

Green light

 384 lm, wavelength 525 nm.

 Array of 252 RGB LEDs.

 Max. voltage 24 V.

Blue light

 240 lm, wavelength 470 nm.

 Array of 252 RGB LEDs.

 Max. voltage 24 V.
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declarations of conformity

DanioVision DVOC-0050


